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Support

Please visit the HP OpenView website at:

http://openview.hp.com/ 

There you will find contact information and details about the products, services, and support that HP 
OpenView offers.

You can go directly to the HP OpenView Software Support Online website at:
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• Downloadable documentation
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• Training information

• Support program information
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Chapter 1
Introducing the Smart Plug-in for 
Exchange

This chapter introduces you to some basic Smart Plug-in for Microsoft® Exchange Server 
(Exchange SPI) concepts and offers an overview of the components that appear in the 
OpenView for Windows console when Exchange SPI is installed. The chapter includes the 
following sections: 

• What the Exchange SPI does

• How the Exchange SPI works with OpenView Operations for Windows

• Service Discovery, Service Maps and the Exchange Topology viewer

• Exchange SPI tools 

• Policy setup, display and deployment

• Introducing Exchange SPI reports and graphs

• Where to find Exchange SPI documentation.
9



What the Exchange SPI does
What the Exchange SPI does
The Exchange SPI adds Exchange 2003, Exchange 2000 and Exchange 5.5 
server-monitoring capabilities to OpenView Operations for Windows. It provides mission 
critical monitoring and management of the enterprise Exchange environment through 
predefined yet customizable policies offering monitored server load and performance, 
client availability, message delivery times, and service level objectives.

With the Exchange SPI configured and deployed to Exchange server systems you will find 
that you can increase Exchange availability and performance, lower the support costs 
associated with the Exchange service, and improve capacity management and planning.

After setup, the Exchange SPI will monitor critical Exchange application/database 
resources, giving you information through the OpenView Operations console in the form 
of service maps, topology views, message alerts, reports and graphs.  

How the Exchange SPI works 
When the Exchange SPI is installed on a management server, and nodes running Microsoft 
Exchange server are added to the OVO Nodes folder, Exchange SPI service discovery 
policies will discover the Exchange environment on those nodes, and deploy 
automatically relevant groups of Exchange SPI policies. The policies trigger actions, or 
messages/alerts being sent to the OVO message browser, or they collect data that is used 
to populate Exchange SPI reports and graphs. 

Auto Discovery and the Service Map

The Exchange SPI uses the OVO discovery service components to discover your 
Exchange topology and services. The discovery process is performed by service discovery 
policies which are automatically deployed when a node becomes an OVO managed node. 

For Exchange 5.5, the Service Discovery policy requires the User name and Password of 
a service account with special Exchange privileges. For more information on this type of 
account and how to create one, see Chapter 7, Exchange 5.5 user privileges.
10



Chapter 1
The Exchange environment services discovered by the service discovery policies are 
displayed in the Exchange organization service map. 

Dynamic service maps

Service maps are created from the topology discovered in your network by the Exchange 
service discovery policies. They are dynamic, reflecting the present time status of your 
Exchange environment.

In the console, display the service map in the details pane by selecting Services > 
Applications and then selecting any level of the Exchange organization. Your Exchange 
organization and its activity can be looked at either in the console tree or in the Service 
Map display. 

Figure 1 Service Map of administrative group servers 
11



How the Exchange SPI works
Problems in the Exchange organization are indicated in the Service maps by colors 
showing severity level (red, orange, yellow, blue). They are also indicated by Critical, 
Major, Minor or Warning messages displayed in the Message Browser. Hovering the 
cursor over any entry in the message browser will display descriptive details. Double-click 
a message to see details.

Figure 2 Partial view of Active Message Browser, for an Exchange administrative 
group 

The buttons in the OpenView toolbar give you easy access to the various ways of viewing 
Exchange activity: 

From left to right: Impacted Services, Root Cause, Service Map, Active Message Browser, 
Acknowledged Message Browser.
12



Chapter 1
Figure 3 Impacted Services from a server problem 

The Impacted Services service map view helps you to see at a glance the nodes or services 
that are affected by any occurrence on a node or service. 
13



How the Exchange SPI works
Figure 4 Root Cause view of an Exchange 5.5 site problem 

The Root Cause service view helps you to see the source of a problem. Root cause 
analysis starts at the level of your selected node or service, stops at the level where the 
cause of the problem lies, and draws a map that shows the source of the problem and the 
nodes or services affected by it.

Exchange Organization

After Exchange topology is discovered, the organization of your Exchange environment 
displays in the console tree under Services, in the various Service maps. The Exchange 
organization in an enterprise can be extremely complex, these views help in visualizing 
the organization from the overview down to the detail level.
14



Chapter 1
Figure 5 Example Service map
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How the Exchange SPI works
OV Topology Viewer

The OV Topology Viewer provides for an easy visualization of your Microsoft Exchange 
environment from a 3-dimensional perspective. The viewer is a tool located in the OVO 
console under Tools >  SPI for Exchange > Exchange 2000 and 2003 > Exchange 
Topology. Using this tool you are able to quickly visualize routing groups, Exchange 
servers and the roles they play within your Exchange organization, by selecting the 
Exchange Topology folder on the console tree. 

To open the Exchange Topology viewer:

1 Select Tools > SPI for Exchange > Exchange 2000 and 2003 > Exchange 
Topology.

2 Double-click OV Topology Viewer.

3 The OV Topology Viewer opens. In the left pane, right click Forests, and select Add 
Forest....

This documentation is written from the Exchange perspective, focusing on the Exchange 
Topology view within the OV Topology Viewer, which collects and displays Exchange 
organization data. If you also have the OpenView Active Directory SPI installed, the OV 
Topology Viewer will open with two folders: Exchange Topology and Site Topology. The 
Site Topology view displays Active Directory and Exchange server information. For more 
details on the Site Topology view see the Active Directory SPI online Help and 
Configuration Guide.
16



Chapter 1
Figure 6 OV-TV: Connect to Forest

4 Identify the Domain Controller or Active Directory Domain which will be 
interrogated for Exchange data. Before selecting the Advanced Exchange Data 
Collection checkbox, see “Concerning Advanced Exchange Data Collection” on 
page 20. Enter the requested information. Click OK.

5 You are informed when the data collection is complete.

Figure 7 OV-TV data collection complete
17



How the Exchange SPI works
6 Click Close, or check the Close the dialog when complete box if you prefer that this 
dialog close automatically in the future.

7 Select Exchange Topology in the left pane. An untitled view of your Exchange 
Topology is displayed in the right pane. Save this view for future use.

Figure 8 OV-TV: 

8 Expand the folders to see your Exchange Organization hierarchy.
18



Chapter 1
Figure 9 Example Exchange Topology console view
19



How the Exchange SPI works
Concerning Advanced Exchange Data Collection

Whether or not the OV Topology Viewer can collect particular Exchange data will depend 
on the specific permissions assigned to components of your Exchange organization, see 
“How can I tell if I have WMI access to an Exchange Server?” on page 26.

On the Connect to Forest... screen, if the option Advanced Data Collection is checked 
you will see the following warning: 

As the warning indicates, the retrieval of this information from a large Exchange 
Organization can take a number of hours. In addition, if it is not successful due to these 
permission limitations, you will not be notified, but must check the error log files for 
connection difficulties to determine if your privileges were sufficient. See “Required WMI 
Security Access permissions” on page 27 for details of required WMI permissions and 
error log file locations.

If you select not to initially collect this data from your entire Exchange organization, 
OV-TV will try to retrieve this same data when the Properties dialog of individual servers 
is opened. If the permissions allow, the query will retrieve data and populate the 
Dependent DC tab on the server Properties dialog. If Advanced Exchange Data 
Collection is selected initially, this tab on the Properties dialog of any servers (where the 
permissions permit) will be populated.
20
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Site Topology viewer

If you have the Active Directory SPI license, there will be a Site Topology folder on the 
console tree, beneath the Exchange Topology folder. 

The Site Topology view shows both Active Directory (AD) and Exchange servers on the 
same map, when: 

• both SPIs are installed

• the correct permissions were set to allow the collection of Exchange data

• Advanced Exchange Data Collection has been performed with the initial data 
collection (through checking the check box).

The advanced Exchange data collection gathers information about where in the Active 
Directory sites the Exchange servers live, and the dependent domain controllers. This 
Exchange information will be present in the Site Topology map, which opens in the details 
pane when you select this folder on the console tree. For more information on the Site 
Topology view, see the Active Directory SPI online Help and Configuration Guide.

Getting Started with the Exchange Topology viewer

When the OV Topology Viewer opens, on the left you see folders containing routing 
groups and servers. On the right you see the graphical representation that places the 
routing groups and server links within a context. While the tree view on the left displays 
the hierarchy of the Exchange organization, the right pane shows the non-hierarchical 
relationships among its components.

Accessing functions: The OV Topology Viewer’s features can be accessed through its 
menu commands, its toolbar buttons, or by context menus within areas on either side of the 
window pane. For complete menu and toolbar descriptions, please refer to the SPI for 
Exchange online Help.    
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Manipulating the Exchange Topology view

You may find when you view the Exchange Topology map that servers do not appear 
within the viewable area. You may also want to resize the viewable area. These and other 
changes are possible as follows: 

Table 1 Modifying the OV Topology Viewer  

Tree/map modification How to do it

To move servers to different 
locations within their routing 
groups.

Drag and drop the server to the desired tile within 
its routing group.

To increase/decrease size of 
row/columns in the map’s grid.

Right-click the unused space on or off the map and 
select View Properties, and the General tab.

To find a server in the tree. On the map, right-click a server and select Find 
Server in Tree.
(Label appears highlighted)

To find a server in the map. In the tree, right-click on the server and select Find 
Server on Map.
(Label appears bold, with larger text)

Move a routing group to a 
different area of the grid

Method #1:

1. Pressing the left mouse button, click the routing 
group and start to drag and drop to the desired area.

2. Drag to edge of view to auto scroll the view.

Method #2

1. Pressing the left mouse button, select the routing 
group and start to drag and drop to the desired area.

2. Still holding the left mouse button down, use the 
arrow keys to change the view of the map.
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Using the keyboard to move around the map.

Accessing Server and Map Properties

After successfully connecting to a forest, the tree is populated and a topological map 
displayed. 

By right-clicking any discovered Exchange server in either the tree or the map and 
selecting Properties, you can view the following Exchange server information:

Table 2 Keyboard Functionality

Keystroke Map function

← left arrow Scrolls the map view to the left approximately one tile 
width.

→ right arrow Scrolls the map view to the right approximately one tile 
width.

Home Scrolls the map view to the left extent. (Vertical 
position remains the same).

End Scrolls the map view to the right extent. (Vertical 
position remains the same).
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Server Properties 

Figure 10 OV-TV server Properties

The information displayed in the server Properties dialog (DNS Host Name, Distinguished 
Name, Object GUID, Server Roles and Dependent Domain Controllers), will be derived 
from the initial Active Directory query (see “Concerning Advanced Exchange Data 
Collection” on page 20). If little or no information is displayed, it is probably a result of 
the required WMI permissions not being granted, see “Required WMI Security Access 
permissions” on page 27.

The server properties information is cached, click Refresh Data if you want the data to be 
updated.
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The Dependant DC tab

Figure 11 Example Dependant DCs

The Dependant domain controllers are listed with their DNS Name, and their Type. If the 
Advanced Exchange Data Collection option was checked initially, this data has already 
been collected and will display. If the option was not checked initially, selecting to view 
the Server Properties activates the collection of this data and it will display in the dialog if 
the appropriate security authorizations are set.

Type: Any of the three types of roles the domain controller can have: Authentication, 
Global Catalog or Configuration.
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Map Properties 

By right-clicking on an unused area of the grid or space off the grid, you can open the 
Exchange Messaging View menu, with the following options:

— Navigator: allows you to view and navigate the entire grid, giving you an 
overview of what you are seeing. The blue rectangle represents the area visible in 
the main view.

— Clear Find: If an object on the map is in focus as a result of the right-click menu 
option Find in View, this will be enabled, and you can select to clear the find.

— View Properties: Many variables of the map view can be modified, for example 
colors of routing groups and lines, as well as line widths and styles.

For more information about the OV Topology Viewer, see the Exchange SPI online Help.

If you have the Active Directory SPI installed and wish to view Active Directory detail 
using the Site Topology View, see the Active Directory SPI online Help. 

FAQs

Can I print the map image? 

No. But you can export the map, save it as .png or as a bitmap, then open it in MS Paint to 
print the file or other graphics programs such as Adobe PaintShop or Photoshop. You can 
also view and print it in the MS Office Picture Manager.

How can I tell if I have WMI access to an Exchange Server?

1  Look in the <OVTV install 
directory>\release\logs\AD_OvADExCollectorErrorLog.txt log 
file.

2  Look for a warning such as:

03/01/05 11:44:53 WARNING: Exception thrown, HR#80070005, Access is 
denied. WMI connection failed to server 
'myExchangeServer01.americas.mycorp.net'. FileName: 
.\OvWmiQuery.cpp Line#128

Or

02/24/05 17:36:24 WARNING: Exception thrown, HR#80041008,  WMI 
connection failed to server 
'myExchangeServer01.americas.mycorp.net'. FileName: 
.\OvWmiQuery.cpp Line#126 
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What log files does OVTV generate?

When you launch OV-TV, it generates OVTV_ConsoleErrorLog.txt and 
OVTV_OvADExCollectorErrorLog.txt 

files located at:

       OVTV install directory>\release\logs\

If you shut down OV-TV, or simply cancel out, or stop then reconnect to a forest, the 
previously created OVTV_ConsoleErrorLog.txtlog file is rolled over into 
OVTV_ConsoleErrorLog.old.txt and the previously created 
OVTV_OvADExCollectorErrorLog.txt is rolled into 
OVTV_OvAdExCollectorErrorLog.old.txt.

Note that the OVTV_OvADExCollectorErrorLog.txt is created only if you 
receive a warning. If no warning occurs, then no files are created.

Required WMI Security Access permissions 

The following permissions are required for the OV Topology Viewer to collect advanced 
Exchange data:

— To get Exchange server site membership data, the OV-TV user must have READ 
and REMOTE access to the WMI namespace root\default.

— To get Exchange server DC dependency data, the OV-TV user must have READ 
and REMOTE access to the WMI namespace root\MicrosoftExchangeV2.

— And to get the DNS servers of a DC, the OV-TV user must have READ and 
REMOTE access to the WMI namespace root\CMIv2.
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Exchange SPI Messages

Policies generate messages and alerts that are displayed in the OpenView message 
browser. They are also forwarded to the appropriate service category and are displayed in 
the Service Maps. 

Double-click messages in the message browser to view the details of any message.

Messages include suggestions for corrective actions, and links to appropriate Microsoft 
information sites.

Figure 12  Message Properties with explanatory text
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Figure 13 Link takes you to relevant Microsoft knowledge base 
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Policy setup and deployment 

Exchange SPI policies are displayed in the OVO console in two places: by group under 
the Policy groups folder, and by type under the Policies grouped by type folder. The 
groupings under Policy groups are organized by Exchange components and services. 
These folder groups are used by the Auto Deploy functionality of OVO. See the Exchange 
SPI online Help for detailed information on policy groups, policy types, and policy 
prerequisites.

EXSPI policies must be deployed according to Microsoft Exchange S0erver version (eg. 
Exchange 2000 policies to nodes running Microsoft Exchange Server 2000). In addition, 
do not deploy EXSPI policies to non-Exchange systems.
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Policy groups

Figure 14 Exchange SPI Policy groups on the console tree 

Exchange 2000 and Exchange 2003 policy groups

Policies for Exchange 2000 and 2003 are in version specific folders, organized in Auto 
Deploy and Manual Deploy groups. By default, Auto Deploy Groups of Exchange SPI 
policies are set to deploy automatically when relevant applications or services are 
discovered on OVO managed nodes. Manual Deploy Groups contain policies requiring 
configuration or special circumstances for deployment.

Exchange 2000 policies are grouped in Auto and Manual deploy groups in the following 
way: 
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Figure 15 Exchange 2000 policy groups

For a complete listing of individual policies, see “Exchange 2000 policies” on page 77, 
individual policy descriptions are in the Exchange SPI online Help, 

Exchange 2003 policies are grouped in Auto and Manual deploy groups in the following 
way: 

Figure 16  Exchange 2003 policy groups
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For a complete listing of individual policies, see “Exchange 2003 policies” on page 68, 
individual policy descriptions are in the Exchange SPI online Help.

Exchange 5.5 policy groups

Policies are organized according to how you might want to deploy them. The EXSPI 
Discovery and EXSPI Quick Start policy groups contain policies that deploy 
automatically to nodes as soon as the nodes become managed by OVO, and contain most 
of the policies you need to get started. The EXSPI Add-Ons policy groups contain policies 
that monitor applications compatible with but not a part of Exchange, such as cc:Mail. The 
EXSPI Advanced policy groups contain policies that require some advanced 
configuration, including the creation of a mailbox, and a service account with special 
Exchange privileges. For a listing of individual policies see “Exchange 2003 policies” on 
page 68. 

• The EXSPI Discovery policy group contains Exchange Service Discovery and Check 
Discovery policies. These policies perform the Exchange service discovery on all 
OVO managed Exchange 5.5 servers, and check for service discovery errors. Before 
deployment, the EXSPI-5.5 Exchange Service Discovery policy needs to be edited 
to include the User name and Password of a service account with special Exchange 
privileges. For more details on this type of account, see “Service account with special 
Exchange privileges” on page 135.

• The EXSPI Quick Start policy group contains the basic policies for monitoring 
Exchange servers, for example, policies to monitor key Exchange services, forward 
application errors and warnings, and monitor messaging queues. These policies need 
no special customization and are deployed automatically to all nodes once they 
become managed by OVO. 

• The EXSPI Add-Ons policy group contains policies to monitor applications 
compatible with, but not a part of Exchange, such as cc:Mail and Chat Service. They 
are available to select, modify and deploy as needed. 

• The EXSPI Advanced policy group contains Reporter policies, Event Log Warnings 
and Information policies and End-to-End Message Ping policies. Once deployed to 
the Exchange server nodes, Advanced policies enable the Exchange SPI to target 
specific data and measure this data against predefined rules, and generate actions, 
reports and graphs. Most Advanced policies require additional configuration.
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Policies grouped by type

Policies grouped by type displays policies organized according to function, for example, 
you find data collection scheduling in Scheduled Task policies; threshold settings in 
Measurement Threshold policies, etc. Further information on policy types is available in 
the OVO online Help.

Figure 17  Measurement Threshold policies displayed in the details pane   
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Using Exchange SPI tools

There are two groups of Exchange SPI tools: Tools > SPI for Exchange > Exchange 5.5, 
and Tools > SPI for Exchange > Exchange 2000 and 2003. 

For Exchange 5.5 the following tools are available:

Figure 18 Exchange SPI Tools for Exchange 5.5   

• The Exchange SPI MBOX Config tool starts the mailbox configuration program that 
automatically creates and configures a mailbox. The user name and password of a 
service account with Exchange User and mailbox creation administrative privileges, 
needs to be given for the tool to execute.

• Trace On/ Tracing Off enables or disables tracing. The default setting is off. Tracing 
is generally used by customer support for troubleshooting purposes.
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For Exchange 2000/2003 the following groups of tools are available

Figure 19 Exchange SPI Tool groups for Exchange 2000 and 2003:

Client SLA Configurations

This tool group contains the following tools for MAPI-based client probes:

• Configure Client MAPI Logon

• Configure Client Message Read 

• Configure Client Message Send 

• MBOX creation for MAPI client based policies 

These tools, used together with associated policies, generate and collect Service Level 
Objective data on various basic client tasks such as logon, sending, and reading E-mail 
messages. See the online Help for more information and procedures.
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End-to-End SLA Configuration

This tool group contains the following tools: 

• MBOX Config: starts the mailbox configuration program that automatically 
configures a mailbox. The user name and password of a service account with 
Exchange administrative privileges needs to be given for the tool to execute.

• End-to-End Configuration: This tool is a wizard for configuring the Message 
Delivery (Ping) Service Level Objective process on Exchange 2000 and 2003 OVO 
managed servers.

See “Configuring Exchange SPI for Message Delivery SLAs” on page 111 for more 
information.

Exchange Server Utilities

This tool group contains the following tools: 

• Enable Message Tracking: enables message tracking on Exchange 2000 and 
Exchange 2003 servers. 

• Mount Exchange Information Store: This tool can search for and mount 
dismounted information or public folder stores. For more information on this tool, see 
the Exchange SPI online Help. 

EXSPI Support

This tool group contains the following tools: 

• Trace On/Tracing Off tools enable or disable tracing. The default setting is off. 
Tracing is generally used by customer support for troubleshooting purposes.

• Self Healing Info: this tool gathers system information, and configuration, log, and 
trace Exchange SPI files, for assisting customer support in troubleshooting problems. 
See the online Help for more information.

Exchange Topology

• OV Topology Viewer: This tool provides for the visualization of Microsoft 
Exchange and directory servers, with a 3-dimensional perspective. See “OV 
Topology Viewer” on page 16 for more details.
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ovo Utilities

This tool group contains the following tools: 

• Exchange Cluster Configuration: This tool prints apminfo data, which can be used 
to create the apminfo.xml file used by the Exchange SPI to recognize clustered 
instances. For further information about Exchange SPI monitoring clusters, see 
“Exchange SPI Clustering support” on page 125.

• Embedded Performance Component Configuration: This tool creates the 
EXSPI_DATA datasource, classes and metrics. It performs the same functions as the 
Auto Deploy policy EXSPI-6.X exspi Agent Configuration in the ovo Exchange 
SPI core > Data Collection group. The tool will list all current datasources prior to 
creation of the EXSPI_DATA datasource. To verify successful creation, wait a few 
minutes after initial execution, and execute the tool again. See “Embedded 
Performance Component (EPC) schema” on page 185 for a complete listing of the 
EPC schema.

OVO Foundation Tools

Some Exchange 5.5 Advanced policies require a Domain Admin account. To help manage 
those accounts, a tool called ovpmpwutil has been added to the OVO foundation tools. 
This tool is not SPI specific. Documentation for ovpmpwutil can be found in the 
Command-line Tools section of HP OpenView Operations for Windows online Help.

Exchange SPI reports and graphs

Located in the appropriate Exchange version folder under SPI for Exchange > Reports 
and Graphs > SPI for Exchange and the Microsoft Exchange version, there are a 
number of preconfigured reports and graphs, grouped by service.

Reports and graphs are populated with data collected by the EXSPI data collection 
policies. Data is consolidated nightly and used to generate reports and graphs the 
following day. Some data collectors run on Saturday/Sunday only and therefore related 
reports are available only after a weekend has passed.

The SPI for Exchange Reports and Graphs folder will not be created until data is 
collected on nodes and the Service Reporter consolidation process has run. Out of the box 
the Reporter Data consolidation process (codaGather.exe) is scheduled to run each day 
shortly after midnight.
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Graphs are near real-time, populated with data contained in the Exchange SPI Embedded 
Performance Component (EPC).

See the Exchange SPI online Help for detailed information about each report, the policies 
that need to be deployed for each report, and troubleshooting tips.

To display a report or graph

When a report/graph group is highlighted in the console tree on the left, the list of reports/
graphs in that group displays on the right in the details pane. Select a report/graph in the 
details pane and double-click. A dialog asks you to select the nodes from which to take 
data, and the date range and level of granularity desired. Click Finish, and the report or 
graph will display.
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Exchange SPI reports

Reports are displayed in the console organized by service. The list of reports available in 
any service category is displayed in the details pane when the service category is selected. 

For a complete listing of Exchange SPI reports, see “Exchange SPI reports” on page 96. 
For details about each report, including troubleshooting tips, see the Exchange SPI online 
Help.

Figure 20  SPI for Exchange 2003 Client Access reports 
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Figure 21 SPI for Exchange report example   
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Exchange SPI graphs

Graphs are displayed in the console organized by service. The list of graphs available in 
any service category is displayed in the details pane when the service category is selected.

SPI for Exchange Graphs are located in Reports and Graphs > Graphs > SPI for 
Exchange (version #). For a complete listing of Exchange SPI graphs, see “Exchange SPI 
graphs” on page 102.

Figure 22 SPI for Exchange 2003 Client Access graphs   
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Where to find Exchange SPI documentation
Cluster configuration and support........................... Config. Guide ch 6

Discovery ................................................................... Config. Guide ch 1

End to End Message Ping ......................................... Config. Guide ch 5

       troubleshooting ................................................... Online Help

EPC schema ............................................................... Config. Guide Appendix C

Getting Started, step-by-step procedures ................ Config. Guide ch 3

Graphs:

         listing by Exchange version ............................. Config. Guide ch 4

MAPI-based client probes ........................................ Online Help

Policies: 

         listing by Exchange version ............................. Config. Guide ch 4

         individual policy descriptions.......................... Online Help

         customizing........................................................ Config. Guide ch 8       

         requirements/pre-requisites............................. Config. Guide ch 4

         changes in this version...................................... Config. Guide ch 2

Reports:

         listing by Exchange version ............................. Config. Guide ch 4 

         report details .................................................... Online Help

         troubleshooting reports.................................... Online Help

         Ex 5.5: configuring and deploying report policies...Config. Guide ch 4

Service accounts:

       setting up for Exchange 5.5................................ Config. Guide ch 8

       setting up for Exchange 2000 am 2003 ............. Config. Guide Appendix D

Service Maps .............................................................. Online Help

Service Reporter Schema.......................................... Config. Guide Appendix B

Tools
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       listing.................................................................... Config. Guide ch 1

       procedures ........................................................... Online Help

Topology Viewer ........................................................ Config Guide ch 1

Upgrading .................................................................. Config. Guide ch 2

Uninstalling ............................................................... Config. Guide ch 8
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Version Details and Upgrading 
This chapter covers upgrading information, and policy and tool changes from the last 
Exchange SPI version to this one.

Policy changes in this version

Threshold changes in policies

In response to customer feedback, the default out-of-the-box threshold values and 
scheduled times within all Exchange 2000 and 2003 policies have been enhanced. Please 
check the properties of individual policies. 

Obsolete policies

– EXSPI-6.0 Dc-IS Msg Delivery Time

– EXSPI-6.0 Dc-IS Public Msg Vol

– EXSPI-6.0 Dc-IS Private Msg Vol

– EXSPI-6.0 Dc-MTA & IS Queue Lengths

– EXSPI-6.0 Dc-Exchange Info

– EXSPI-6.0 Dc-MTA Message Volume

– EXSPI-6.0 Create Coda Data Sources
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Policy changes in this version
– EXSPI-6.0 Dc-User Connections

– EXSPI-6.0 Dc-SMTP Message Volume

– EXSPI-6.0 Measurement Data Collector

New policies 

ActiveSync:

• EXSPI-6.5 ActiveSync AD requests 

• EXSPI-6.5 ActiveSync Mailbox Connection requests 

• EXSPI-6.5 ActiveSync Mailbox pending requests 

• EXSPI-6.5 ActiveSync Users 

• EXSPI-6.5 DC ActiveSync

• EXSPI-6.5 DC ActiveSyncNotify

OMA (Outlook Mobile Access):

• EXSPI-6.5 OMA Response time 

• EXSPI-6.5 OMA Application Event Errors

• EXSPI-6.5 DC OMA 

MAPI (Messaging Application Programming/Protocol Interface):

• EXSPI-6.X Information Store RPC Averaged Latency

Outlook 2003

• EXSPI-6.5 Outlook Client Latency 

• EXSPI-6.5 Outlook Client RPC Failure Rate 

• EXSPI-6.5 DC Outlook Client 

OWA (Outlook Web Access)

• EXSPI-6.X OWA Current Connections 

• EXSPI-6.X Dc- OWA Back End

• EXSPI-6.X Dc-OWA Front End
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• EXSPI-6.X HTTP Port Response

IMAP4 (Internet Message Access Protocol, version 4) 

• EXSPI-6.X IMAP4 Failed Connection Rate

• EXSPI-6.X IMAP4 Rejected Connection Rate

• EXSPI-6.X IMAP4 Connections

• EXSPI-6.X IMAP4 Port Response

• EXSPI-6.X-Dc IMAP4 Performance

POP3 (Post Office Protocol version 3): 

• EXSPI-6.X POP3 Failed Connections Rate

• EXSPI-6.X POP3 Rejected Connections Rate

• EXSPI-6.X POP3 Connections

• EXSPI-6.X POP3 Port Response

• EXSPI-6.X-Dc POP3 Connections

Clusters:

• EXSPI-6.X Cluster Connection Limits

Full Text Index:

• EXSPI-6.X 0074

• EXSPI-6.X DC Full Text Index 

Mailbox:

• EXSPI-6.X Dc-IS Mailbox Performance

IS (Information Store) Performance:

• EXSPI-6.X Information Store User Count

• EXSPI-6.X Information Store Db Cache Size

• EXSPI-6.X Information Store VM Largest Block

• EXSPI-6.X Information Store VM 16MB Blocks
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Policy changes in this version
• EXSPI-6.X Information Store VM Large Block Bytes

• EXSPI-6.5 Information Store Additional Heaps

• EXSPI-6.5 Information Store Memory Errors

• EXSPI-6.5 Information Store Heap Memory Errors

• EXSPI-6.X Dc-Information Store Performance

• EXSPI-6.5 Check Memory Configuration

Public Folder:

• EXSPI-6.X Dc-IS Public Folder Performance

Transaction log:

• EXSPI-6.X Transaction Log BackUp Check

• EXSPI-6.X-0008

SMTP:

• EXSPI-6.X SMTP Port Response

• EXSPI-6.X Dc-SMTP Server Performance

• EXSPI-6.X DC SMTP Virtual Server Storage

• EXSPI-6.X-0082

• EXSPI-6.X-0083

• EXSPI-6.X-0084

• EXSPI-6.X-0085

• EXSPI-6.X-0086

• EXSPI-6.X-0087

Tracking Log:

• EXSPI-6.X Dc-TrackLog SLA Delivery

• EXSPI-6.X Dc-Message Tracking Log Space Usage

• EXSPI-6.X-0076
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MTA (Message Transfer Agent):

• EXSPI-6.X DC X.400 Service MTA Queue 

• EXSPI-6.X Dc-MTA Performance

• EXSPI-6.X-0075

Lotus Notes:

• EXSPI-6.0 Lotus Notes Process Monitor

SRS (Site Replication Service):

• EXSPI-6.X SRS Process Monitor

• EXSPI-6.X SRS Service 

Active Directory Connector Server:

• EXSPI-6.X ADC Service 

• EXSPI-6.X ADC Operation Failure Rate

• EXSPI-6.X ADC Import Failure Rate

• EXSPI-6.X ADC Process Monitor

Client Accessibility:

• EXSPI-6.X Client Message Read

• EXSPI-6.X Client MAPI Logon

• EXSPI-6.X Client Message Send

ovo Exchange SPI core/ Data Collection:

• EXSPI-6.X exspi Agent Configuration

Re-organization of policies, reports and graphs

Policies, reports and graphs are in folders according to Exchange version.

For Exchange 2003 and 2000

• The policy groupings Quick Start, Add-Ons and Advanced are obsolete. 
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Policy changes in this version
• Policies are grouped in Auto Deploy Groups and Manual Deploy Groups. All Auto 
Deploy policies are automatically deployed to managed nodes. Manual Deploy 
policies require some manual configuration, or special circumstances, before 
deployment.

• Policies in Manual Deploy and Auto Deploy groups are grouped based on a 
service-centric view of Exchange. See Chapter 4, Using Exchange SPI policies, 
reports and graphs for more details.

Renaming of policies in this version

• All policies for both Exchange 2000 and 2003 versions, now have the prefix 6.X

• All policies for the Exchange 2000 version only, now have the prefix 6.0.

• All policies for the Exchange 2003 version only, now have the prefix 6.5.
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Upgrading Exchange SPI from B.08.00
IT IS IMPORTANT TO FOLLOW THE UPGRADE INSTRUCTIONS. FAILURE TO 
DO SO MAY RESULT IN UNPREDICTABLE OVO MANAGEMENT SERVER, OVO 
CONSOLE, AND OVO MANAGED NODE STATE, OR LOSS OF HISTORICAL 
EXCHANGE SPI DATA. 

 The procedure for upgrade from Exchange SPI version B.08.00 to B.09.00 is 
accomplished with the following tasks:

1 Upgrade the OVO management server from OVO for Windows 7.21 to OVO for 
Windows 7.5, see the HP OpenView Operations for Windows, Upgrade Guide, 
Software Version 7.50, for procedures.

2 Remove the SPI of Exchange Tools group.

3 Install Exchange SPI Version B.09.00 from the Application SPI CD.

4 After the install completes note that the policy group SPI for Exchange is renamed to 
SPI for Exchange Version 8.

5 Determine which of your SPI for Exchange Version 8 policies contain customizations 
that are desired in the new version of the product and manually merge them. 
Examples of customizations to carry forward into the new product include thresholds 
and schedules.

6 If managing Exchange 5.5 servers:

a Copy the configuration contents of the EXSPI 5.5 Ping Config to the new version 
(9) of this policy.

b Update all policies that contain user account information such as Advanced Data 
Collectors and the Service Discovery policy

7 Un-deploy all old Exchange SPI policies from all managed nodes. 

8 For Auto-Deployment of polices you must remove the existing portion of the Service 
map associated with the managed Exchange node, by using Configure Services to 
delete the Server from the Exchange Service map. NOTE: For manual deployment 
of polices ignore this step.

For Side by Side migration procedure to upgrade to OVO 7.5 cluster, see the HP 
OpenView Operations for Windows, Upgrade Guide, Software Version 7.50.
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9 Upgrade the Agent on the nodes by deploying the Openview Operations Agent – 
located in the Packages folder of the OVO console.

10 Deploy Discovery:

a For Exchange 2000 and 2003: Deploy the Exchange Discovery policy group for 
the appropriate version. For example, to all Exchange 2003 servers deploy the 
SPI for Exchange > Exchange 2003 > Auto Deploy Groups > ovo Exchange SPI 
core > Exchange Discovery policy group. This action will discover the node’s 
Exchange Services and deploy the corresponding policy groups and 
instrumentation.

b For Exchange 5.5: Deploy the EXSPI Discovery policy group.
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Getting started

Getting started managing Exchange 2000 and 
2003 servers

A1. Install the HP OpenView Smart Plug-ins CD

Install the SPI CD, and select the SPI for Exchange component.

Please see the HP OpenView Smart Plug-ins, New and Upgraded, for OpenView 
Operations/Performance for Windows Installation/Upgrade Guide included with the 
product. This guide offers a product overview as well as the location of the latest 
Exchange SPI Release Notes, which you should print and read before getting started. 

2. Select nodes to manage

• In the OVO console tree select Nodes. Right-click, select Configure Nodes and 
check the nodes to manage. Wait about five minutes, as the following occurs on 
the managed nodes, without user intervention:

— As the Exchange server role is discovered, relevant policies for Exchange 
2000 and 2003 servers in the Auto Deploy Groups are auto-deployed to the 
newly managed nodes. 
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— If Exchange is discovered on the newly managed node the Exchange 
topology is determined and stored in WMI. This topology is used to populate 
the OVO Exchange Service Map.

— Any events that require operator action are sent to the active message 
browser and the corresponding service map nodes.

3. Modify policy threshold values, as desired

The SPI for Exchange policy thresholds are set up based on customer feedback, Microsoft 
best practices, and consultant recomendations.The operator may modify the factory set 
thresholds as appropriate for their Exchange activity. 

Some of the Measurement Threshold polices contain embedded script. To change 
threshold values for these types of polices open the script and change the following 
parameters:

NOTE: Any modification to a threshold on a policy requires that policy to be re-deployed.

4. Configure the End-to-End Message Ping 

See “Exchange 2000/2003: monitoring message delivery SLAs” on page 112 for details. 

5. Configure the MAPI Service Level Objective policies

See the Exchange SPI online Help for procedures.

Const THRESHOLD = 10  This is the threshold used for the rule 
alarm.

Const CONSECUTIVE = 3 How many consecutive times that me
value exceeds the threshold before sen
an alarm.

Const CONSECUTIVEMAX = 6 When the metric exceeds the threshol
is improving then CONSECUTIVE M
intervals are allowed before an alarm 
sent.

Const THRESHOLDCHANGEMAGNITUDE =0 The threshold will be ignored, instead
metric value is allowed to deviate from
observed value by the MAGNITUDE
CHANGE from interval to interval.
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6. Deploy Manual Deploy Groups policies, as desired

Exchange Service Discovery

The Exchange SPI implements an LDAP based Exchange topology discovery. The 
discovered topology is maintained in the OpenView namespace on the management server 
or console.

• How it works 

Exchange 2000 and 2003 topology is discovered by the EXSPI-6.X Exchange Service 
Discovery policy, which is automatically deployed to all Windows nodes after they are 
selected to become OVO managed nodes. 

• Service Map 

The discovered Exchange organization is displayed in the OVO details pane, in various 
Service Maps.

Figure 1  Service view of one Exchange 2000 routing group 
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The Organization, with the name given by the Exchange administrator, is located beneath 
the Exchange folder on the OVO console tree. The hierarchical structure below the 
organization name are folders mirroring your Exchange organizational structure. In the 
case of OVO managed nodes, all services are listed by product name. 

Identify Exchange servers/services

The Exchange topology is discovered by the Service Discovery policies and the 
information is visible in the Organizations under Services > Applications > Microsoft 
Exchange on the OVO console tree. 

Figure 2 Hierarchy of an Exchange organization   

If an Exchange server is listed in the tree with no services listed under it, it is an 
unmanaged server. If you wish it to be managed by OVO, perform “3. Add Exchange 5.5 
servers to the Nodes folder” on page 57, now. 
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Getting started managing Exchange 5.5 servers

1. Install the HP OpenView Smart Plug-ins CD

Install the SPI CD, and select the SPI for Exchange component.

Please see the HP OpenView Smart Plug-ins, New and Upgraded, for OpenView 
Operations/Performance for Windows Installation/Upgrade Guide included with the 
product. This guide offers a product overview as well as the location of the latest 
Exchange SPI Release Notes, which you should print and read before getting started. 

2. Add User name and Password to EXSPI-5.5 Exchange Service 
Discovery

When the SPI is installed, open the EXSPI-5.5 Exchange Service Discovery policy in the 
Policy Management > SPI for Exchange > Exchange 5.5 > EXSPI Discovery folder on the 
OVO console. Add the User name and Password of a service account with special 
Exchange privileges. For information on this type of account, and how to create one, see 
Chapter 7, Exchange 5.5 user privileges.

3. Add Exchange 5.5 servers to the Nodes folder

The servers whose services you want to discover and monitor must be included in the 
Nodes folder of the OVO management console. Discovered Exchange servers without 
discovered services are not managed nodes. To monitor servers, add them to the OVO 
Nodes folder now.

To add an Exchange server to the Nodes folder

1 In the OVO console, right-click the Nodes folder, select Configure Nodes
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Figure 3 Nodes > Configure Nodes Menu 

2 In the Configure Managed Nodes dialog, drag and drop servers listed on the left to the 
OVO Nodes folder on the right. 

4. Manual Exchange Service Discovery policy deployment, if 
required

After adding Exchange servers to the Nodes folder, the EXSPI Exchange Service 
Discovery policy will automatically deploy.

To perform this step manually

1 In the OVO console tree expand the folders Policy Management > Policy Groups > 
SPI for Exchange > Exchange 5.5 > EXSPI Discovery.

2 In the details pane select EXSPI-5.5 Exchange Service Discovery and right-click.

3 Select All Tasks, then Deploy On. In the dialog select the nodes you wish the 
discovery to be deployed on.

After allowing about five minutes, it will be possible to view the structure of Exchange 
services. 

5. Policy deployment, as desired

After discovery, the version specific policies in Quick Start are auto deployed.

Select and deploy policies in the Add-Ons and Advanced policy groups, see Chapter 4, 
Using Exchange SPI policies, reports and graphs for more details.
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6. Verify installation results

1 In the OVO Manager console expand the Nodes folder.

2 Right-click the node on which to verify deployment and select View > Policy 
Inventory.

Exchange Service Discovery

The Exchange SPI implements an LDAP based Exchange topology discovery. The 
discovered topology is maintained in the OpenView namespace on the management server 
or console.

• How it works 

Exchange 5.5 topology is discovered by the EXSPI-5.5 Exchange Service Discovery 
policy, which is automatically deployed to all Windows nodes after they are selected to 
become OVO managed nodes. 

• Service Map 

The discovered Exchange organization is displayed in the OVO details pane, in various 
Service Maps.

The Organization, with the name given by the Exchange administrator, is located beneath 
the Exchange folder on the OVO console tree. The hierarchical structure below the 
organization name are folders mirroring your Exchange organizational structure. In the 
case of OVO managed nodes, all services are listed by product name. 

The user ID and password of a service account with special Active Directory privileges 
must be added to the EXSPI-5.5 Exchange Service Discovery policy before deployment. 
For information on this type of account, and how to create one, see Chapter 7, Exchange 
5.5 user privileges.
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Figure 4 Exchange 5.5 Organization hierarchy, and service map

Identify Exchange servers/services

The Exchange topology is discovered by the Service Discovery policy and the information 
is visible in the folders labeled Exchange 5.5 > Services > Applications on the OVO 
console tree. By expanding this folder, you see the organization of your Exchange 
services.
60



Chapter 3
If an Exchange server is listed in the tree with no services listed under it, it is an 
unmanaged server. If you wish it to be managed by OVO, perform Task 2 “3. Add 
Exchange 5.5 servers to the Nodes folder” on page 57, now.

For Exchange 5.5, the Service Discovery policy requires the User name and Password of 
a service account with special Active Directory and Exchange privileges. For more 
information on this type of account and how to create one, see Chapter 7, Exchange 5.5 
user privileges.
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Suggested daily tasks
Areas to be routinely monitored are: 

• The OVO message browser 

Watch for warning and critical messages or multiple alarms. Read the associated 
instruction text for recommended actions.

If too many alarms of a particular type are occurring and servers seem to be 
performing correctly, you likely need to adjust the policy threshold that is causing the 
alarm. See the OVO online Help for instructions on how to adjust a threshold in a 
policy.

• The Exchange SPI reports and graphs

When you become aware of problems with a server, use the OVO reporting function 
to display additional data, or view historical trends in graphs. 

• The Service Map

Use the Service Map View to see which services are impacted by any message alarm.

• The OpenView Topology Viewer

Monitor changes to your Exchange Organization by using the OV Topology Viewer. 
See “OV Topology Viewer” on page 16 for more details. 
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Regarding reporting
• For Exchange 2000 and 2003, the Auto Deploy folders contain basic schedule 

policies that perform the data collection/logging work on the managed nodes. For 
Exchange 5.5, these policies are in the Advanced policy group and need to be 
manually deployed, see “5. Policy deployment, as desired” on page 58.

• All SPI for Exchange graphs populate with data that is maintained on the managed 
node. These graphs are best viewed with 12 to 48 hours of data.

• Most SPI for Exchange reports populate with Service Reporter data after one day. 
This is due to the fact that the Service Reporter data gathering process needs to run at 
least once. Trend reports require at least three days of data gathered from the managed 
nodes. Some data collection policies only run on Saturday/Sunday, so some reports 
will not have data until after a Saturday/Sunday collection is performed. See the 
Exchange SPI online Help for a mapping of data collection policies to reports. 

• The SPI for Exchange Reports folder will not be created until data is collected on 
nodes and the Service Reporter consolidation process has run. Out of the box the 
Reporter Data consolidation process (codaGather.exe) is scheduled to run each 
day shortly after midnight.

• For full functionality of Exchange SPI reports, the full version of Reporter, or 
Reporter-lite, must be installed on the same management server as OpenView 
Operations for Windows. Both versions of Reporter are supported within the 
Exchange SPI reporting package.
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Using Exchange SPI policies, reports 
and graphs

This chapter contains tables of Exchange SPI policies, reports and graphs, and outlines 
procedures for: 

• Deploying the various policy groups

• Generating Exchange SPI reports and graphs.
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Using Exchange SPI policies

• Some policies in the SPI for Exchange policy groups require that particular software 
components/services are installed on Exchange server systems before the deployed 
policies will work. 

• For many Exchange 5.5 data collection policies, you must configure a service account 
with special Exchange privileges, see “Creating a service account for Exchange 5.5 
servers” on page 137. 

• EXSPI policies should not be deployed to non-Exchange systems.

• Regarding policy names:

— policies for Exchange 2003 only, have the prefix EXSPI-6.5

— policies for Exchange 2000 only, have the prefix EXSPI-6.0 

— policies for Exchange version 2000 and 2003, have the prefix EXSPI-6.X 

— policies for Exchange version 5.5 only, have the prefix EXSPI-5.5.

• Updating the account information (user name and password) in many policies at once 
on the management server can be performed using the HP OpenView Operations for 
Windows tool called ovpmpwutil. Detailed procedures for using ovpmpwutil can be 
found in the Command-line Tools section of HP OpenView Operations for Windows 
online Help.

Use the following tables to decide which policies you want to install. Policy Group 
Descriptions show you what type of data/functionality the policy group offers.

Individual policy definitions are documented in the Exchange SPI online Help.

Policy Groups are located in the console tree under Policy Management > Policy Groups 
> SPI for Exchange and then the Exchange version.

Important Microsoft Information on the Web: Before you deploy Exchange SPI policies, 
please refer to the Microsoft article “PRB: Performance Object Is Not Displayed in 
Performance Monitor” at this URL: http://support.microsoft.com/support/kb/articles/
Q248/9/93.ASP.

The article contains information on editing the Windows registry so that performance 
objects (tracked by Performance Monitor) are always enabled. A disabled performance 
object could cause an Exchange SPI policy to fail. By following the instructions in the 
article, you can ensure that policies are able to collect Exchange performance data as 
expected.
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Figure 5 SPI for Exchange policy location on the console tree   
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Exchange 2003 policies

Exchange 2003 Auto Deploy policies  

Exchange 2003 
Auto Deploy Groups Policies

Availability EXSPI-6.X Queue State
EXSPI-6.X Connector State
EXSPI-6.X Exchange System Errors
EXSPI-6.X Link State
EXSPI-6.X Exchange Services
EXSPI-6.X Process Monitor
EXSPI-6.X Exchange Application Errors
EXSPI-6.X Inactive Process Monitor
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Client Accessibility ActiveSync
             EXSPI-6.5 ActiveSync AD Requests
             EXSPI-6.5 ActiveSync Mailbox Connection Requests
             EXSPI-6.5 ActiveSync Mailbox pending requests
             EXSPI-6.5 ActiveSync Users
             EXSPI-6.5 Dc-ActiveSync
             EXSPI-6.5 Dc-ActiveSyncNotify
OMA
             EXSPI-6.5 OMA Response time
             EXSPI-6.5 Dc-OMA
             EXSPI-6.5 OMA Application Event Errors
IMAP4
             EXSPI-6.X IMAP4 Failed Connection Rate
             EXSPI-6.X IMAP4 Rejected Connection Rate
             EXSPI-6.X IMAP4 Connections
             EXSPI-6.X Dc-IMAP4 Performance
             EXSPI-6.X IMAP4 Port Response
MAPI
             EXSPI-6.X Information Store RPC Requests
             EXSPI-6.X Information Store RPC Operations
             EXSPI-6.X Information Store RPC Averaged Latency
Outlook 2003
             EXSPI-6.5 Dc-Outlook Client
             EXSPI-6.5 Outlook Client Latency
             EXSPI-6.5 Outlook Client RPC Failure Rate

Exchange 2003 
Auto Deploy Groups Policies
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Client Accessibility (cont) OWA
Front End:
             EXSPI-6.X OWA Current Connections
             EXSPI-6.X Dc-OWA Front End
             EXSPI-6.X HTTP Port Response
Back End:
             EXSPI-6.X Dc-OWA Back End
POP3
             EXSPI-6.X POP3 Failed Connection Rate
             EXSPI-6.X POP3 Rejected Connection Rate
             EXSPI-6.X POP3 Connections
             EXSPI-6.X Dc-POP3 Performance
             EXSPI-6.X POP3 Port Response

Cluster EXSPI-6.X Exchange Cluster Discovery SysLog
EXSPI-6.X Cluster Connection Limits

Directory EXSPI-6.X DSAccess Cache Hit-Miss Ratio
EXSPI-6.X Dc-DSAccess Performance
EXSPI-6.X DSAccess Application Errors

Exchange 2003 
Auto Deploy Groups Policies
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Information Store Epoxy
             EXSPI-6.5 Epoxy Store Out Queue Length
             EXSPI-6.5 Epoxy Client Out Queue Length
Full Text Index
             EXSPI-6.X Dc-Full Text Index
             EXSPI-6.X-0074
Mailbox
             EXSPI-6.X IS Mailbox Average Delivery Time
             EXSPI-6.X IS Mailbox Receive Queue Length
             EXSPI-6.X IS Mailbox Send Queue Length
             EXSPI-6.X Database Mounted Search
             EXSPI-6.X 1h-Mailbox Space Usage
             EXSPI-6.X Dc-Mailbox IS Sum. Data
             EXSPI-6.X Dc-Mailbox Data
             EXSPI-6.X Dc-IS Mailbox Performance
             EXSPI-6.X Database Mounted Check
             EXSPI-6.X-0070
Performance
             EXSPI-6.X Information Store Db Cache Size
             EXSPI-6.X Information Store Db Log Threads Waiting
             EXSPI-6.X Information Store Db Log Record Stalls per sec
             EXSPI-6.X Information Store Db Log Writes per sec
             EXSPI-6.X Dc-Information Store Performance
             EXSPI-6.X Information Store User Count
             EXSPI-6.X Information Store VM Largest Block
             EXSPI-6.X Information Store VM 16MB Blocks
             EXSPI-6.X Information Store VM Large Block Bytes
             EXSPI-6.X Check Memory Configuration
             EXSPI-6.5 Information Store Additional Heaps
             EXSPI-6.5 Information Store Memory Errors
             EXSPI-6.5 Information Store Heap Memory Errors

Exchange 2003 
Auto Deploy Groups Policies
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Information Store (cont) Public Folder
             EXSPI-6.X IS Public Replication Queue Length
             EXSPI-6.X 1h-Public Folder Space Usage
             EXSPI-6.X Dc-IS Public Folder Performance
             EXSPI-6.X Database Mounted Search
             EXSPI-6.X Database Mounted Check
             EXSPI-6.X Dc-Public Folder Data
             EXSPI-6.X IS Public Receive Queue Length
             EXSPI-6.X Dc-Public IS Sum. Data
             EXSPI-6.X IS Public Send Queue Length
             EXSPI-6.X IS Public Average Delivery Time
             EXSPI-6.X-0072
Transaction Log
             EXSPI-6.X-0004
             EXSPI-6.X-0008
             EXSPI-6.X Transaction Log BackUp Check
             EXSPI-6.X Transaction Log Space Usage
Virus Scan
             EXSPI-6.X Virus Scan Messages Quarantined per Sec
             EXSPI-6.X Virus Scan Files Cleaned per Sec
            EXSPI-6.X Virus Scan Queue Length
             EXSPI-6.X Virus Scan Files Quarantined per sec
             EXSPI-6.X Virus Scan Messages Cleaned per Sec

Exchange 2003 
Auto Deploy Groups Policies
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Messaging cc:Mail Connector
             EXSPI-6.X 1h-ccMail Connector
             EXSPI-6.X-0091
             EXSPI-6.X 5m-ccMail Connector
             EXSPI-6.X-0093
             EXSPI-6.X-0092
             EXSPI-6.X-0090
Lotus Notes Connector
             EXSPI-6.X Lotus Notes Process Monitor
             EXSPI-6.X-0094
             EXSPI-6.X 1h-Lotus Notes Connector
             EXSPI-6.X-0095
             EXSPI-6.X-0096
             EXSPI-6.X-0096
             EXSPI-6.X 5m-Lotus Notes Connector
MTA
             EXSPI-6.X MTA Work Queue Length
             EXSPI-6.X Dc-MTA Performance
             EXSPI-6.X MTA Rejected Inbound Messages
             EXSPI-6.X MTA Connection Queue Lengths
             EXSPI-6.X MTA Failed Outbound Associations
             EXSPI-6.X MTA Failed Conversions
             EXSPI-6.X MTA Message Delay
             EXSPI-6.X MTA Connection Message Delay
             EXSPI-6.X MTA Rejected Inbound Associations
             EXSPI-6.X Dc-X.400 Service MTA Queue
             EXSPI-6.X-0075
NNTP
             EXSPI-6.X 1h-NNTP
             EXSPI-6.X-0058

Exchange 2003 
Auto Deploy Groups Policies
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Messaging (cont) SMTP
             EXSPI-6.X SMTP Messages Pending Routing
             EXSPI-6.X SMTP Categorizer Queue Length
             EXSPI-6.X SMTP Local Queue Length
             EXSPI-6.X SMTP Local Retry Queue Length
             EXSPI-6.X Dc-SMTP Server Performance
             EXSPI-6.X Dc-SMTP Queues
             EXSPI-6.X SMTP NDR Percentage
             EXSPI-6.X SMTP Outbound Connections Refused
             EXSPI-6.X SMTP Remote Queue Length
             EXSPI-6.X SMTP Remote Retry Queue Length
             EXSPI-6.X Dc-SMTP Virtual Server Storage
             EXSPI-6.X-0082
             EXSPI-6.X-0083
             EXSPI-6.X-0084
             EXSPI-6.X-0085
             EXSPI-6.X-0086
             EXSPI-6.X-0087
             EXSPI-6.X SMTP Port Response
Tracking Log
             EXSPI-6.X Dc-TrackLog Data
             EXSPI-6.X Dc-TrackLog SLA Delivery
             EXSPI-6.X Dc-Message Tracking Log Space Usage
             EXSPI-6.X-0076

Exchange 2003 
Auto Deploy Groups Policies
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Exchange 2003 Manual Deploy policies

ovo Exchange SPI core Data Collection
             EXSPI-6.X exspi Agent Configuration
             EXSPI-6.X Messages
Exchange Discovery
             EXSPI-6.X Check Discovery
             EXSPI-6.X Exchange Service Discovery
             EXSPI-6.X Exchange Cluster Discovery SysLog

Exchange 2003 
Manual Deploy Groups Policies

Site Replication Service            EXSPI-6.X SRS Process Monitor
           EXSPI-6.X SRS Service
           EXSPI-6.X-0112
           EXSPI-6.X SRS Pending Synchronizations
           EXSPI-6.X SRS Data Space Usage
           EXSPI-6.X SRS Remaining Updates
           EXSPI-6.X-0113

Active Directory 
Connector Server

           EXSPI-6.X ADC Process Monitor
           EXSPI-6.X ADC Service
           EXSPI-6.X ADC Import Failure Rate
           EXSPI-6.X ADC Operation Failure Rate

Exchange 2003 
Auto Deploy Groups Policies
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Exchange Server
 

Availability
             EXSPI-6.X Server State
             EXSPI-6.X Exchange Application Information
             EXSPI-6.X Exchange System Information
             EXSPI-6.X Exchange Application Warnings
             EXSPI-6.X Exchange System Warnings
Transaction Log
             EXSPI-6.X-0005
             EXSPI-6.X-0006
             EXSPI-6.X Transaction Log Storage Use
Message Delivery
             EXSPI-6.X End to End Message Ping
Client Accessibility
             EXSPI-6.X Client Message Read
             EXSPI-6.X Client MAPI Logon
             EXSPI-6.X Client Message Send

Exchange 2003 
Manual Deploy Groups Policies
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Exchange 2000 policies

Exchange 2000 Auto Deploy policies    

Exchange 2000
Auto Deploy Groups Policies

Availability EXSPI-6.X Queue State
EXSPI-6.X Connector State
EXSPI-6.X Exchange System Errors
EXSPI-6.X Link State
EXSPI-6.X Exchange Services
EXSPI-6.X Process Monitor
EXSPI-6.X Exchange Application Errors
EXSPI-6.X Inactive Process Monitor
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Client Accessibility IMAP4
             EXSPI-6.X IMAP4 Failed Connection Rate
             EXSPI-6.X IMAP4 Rejected Connection Rate
             EXSPI-6.X IMAP4 Connections
             EXSPI-6.X Dc-IMAP4 Performance
             EXSPI-6.X IMAP4 Port Response
MAPI
             EXSPI-6.X Information Store RPC Requests
             EXSPI-6.X Information Store RPC Operations
             EXSPI-6.X Information Store RPC Averaged Latency
OWA
Front End:
             EXSPI-6.X OWA Current Connections
             EXSPI-6.X Dc-OWA Front End
             EXSPI-6.X HTTP Port Response
Back End:
             EXSPI-6.X Dc-OWA Back End
POP3
             EXSPI-6.X POP3 Failed Connection Rate
             EXSPI-6.X POP3 Rejected Connection Rate
             EXSPI-6.X POP3 Connections
             EXSPI-6.X Dc-POP3 Performance
             EXSPI-6.X POP3 Port Response

Cluster EXSPI-6.X Exchange Cluster Discovery SysLog
EXSPI-6.0 Exchange Cluster Discovery AppLog
EXSPI-6.X Cluster Connection Limits

Directory EXSPI-6.X DSAccess Cache Hit-Miss Ratio
EXSPI-6.X Dc-DSAccess Performance
EXSPI-6.X DSAccess Application Errors

Exchange 2000
Auto Deploy Groups Policies
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Information Store Epoxy
             EXSPI-6.0 Epoxy Store Out Queue Length
             EXSPI-6.0 Epoxy Client Out Queue Length
Full Text Index
             EXSPI-6.X Dc-Full Text Index
             EXSPI-6.X-0074
Mailbox
             EXSPI-6.X IS Mailbox Average Delivery Time
             EXSPI-6.X IS Mailbox Receive Queue Length
             EXSPI-6.X IS Mailbox Send Queue Length
             EXSPI-6.X Database Mounted Search
             EXSPI-6.X 1h-Mailbox Space Usage
             EXSPI-6.X Dc-Mailbox IS Sum. Data
             EXSPI-6.X Dc-Mailbox Data
             EXSPI-6.X Dc-IS Mailbox Performance
             EXSPI-6.0 IS Mailbox Average Local Delivery Time
             EXSPI-6.X Database Mounted Check
             EXSPI-6.X-0070
Performance
             EXSPI-6.X Information Store Db Cache Size
             EXSPI-6.X Information Store Db Log Threads Waiting
             EXSPI-6.X Information Store Db Log Record Stalls per sec
             EXSPI-6.X Information Store Db Log Writes per sec
             EXSPI-6.X Dc-Information Store Performance
             EXSPI-6.X Information Store User Count
             EXSPI-6.X Information Store VM Largest Block
             EXSPI-6.X Information Store VM 16MB Blocks
             EXSPI-6.X Information Store VM Large Block Bytes
             EXSPI-6.X Check Memory Configuration

Exchange 2000
Auto Deploy Groups Policies
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Information Store (cont) Public Folder
             EXSPI-6.X IS Public Replication Queue Length
             EXSPI-6.X 1h-Public Folder Space Usage
             EXSPI-6.0 IS Public Average Local Delivery Time
             EXSPI-6.X Database Mounted Search
             EXSPI-6.X Database Mounted Check
             EXSPI-6.X Dc-Public Folder Data
             EXSPI-6.X IS Public Receive Queue Length
             EXSPI-6.X Dc-Public IS Sum. Data
             EXSPI-6.X Dc-IS Public Folder Performance
             EXSPI-6.X IS Public Send Queue Length
             EXSPI-6.X IS Public Average Delivery Time
             EXSPI-6.X-0072
Transaction Log
             EXSPI-6.X-0004
             EXSPI-6.X-0008
             EXSPI-6.X Transaction Log BackUp Check
             EXSPI-6.X Transaction Log Space Usage
Virus Scan
             EXSPI-6.X Virus Scan Messages Quarantined per Sec
             EXSPI-6.X Virus Scan Files Cleaned per Sec
            EXSPI-6.X Virus Scan Queue Length
             EXSPI-6.X Virus Scan Files Quarantined per sec
             EXSPI-6.X Virus Scan Messages Cleaned per Sec

Exchange 2000
Auto Deploy Groups Policies
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Messaging cc:Mail Connector
             EXSPI-6.X 1h-ccMail Connector
             EXSPI-6.X-0091
             EXSPI-6.X 5m-ccMail Connector
             EXSPI-6.X-0093
             EXSPI-6.X-0092
             EXSPI-6.X-0090
Lotus Notes Connector
             EXSPI-6.X Lotus Notes Process Monitor
             EXSPI-6.X-0094
             EXSPI-6.X 1h-Lotus Notes Connector
             EXSPI-6.X-0095
             EXSPI-6.X-0096
             EXSPI-6.X-0097
             EXSPI-6.X 5m-Lotus Notes Connector
MTA
             EXSPI-6.X MTA Work Queue Length
             EXSPI-6.X Dc-MTA Performance
             EXSPI-6.X MTA Rejected Inbound Messages
             EXSPI-6.X MTA Connection Queue Lengths
             EXSPI-6.X MTA Failed Outbound Associations
             EXSPI-6.X MTA Failed Conversions
             EXSPI-6.X MTA Message Delay
             EXSPI-6.X MTA Connection Message Delay
             EXSPI-6.X MTA Rejected Inbound Associations
             EXSPI-6.X Dc-X.400 Service MTA Queue
             EXSPI-6.X-0075
NNTP
             EXSPI-6.X 1h-NNTP
             EXSPI-6.X-0058

Exchange 2000
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Messaging (cont) SMTP
             EXSPI-6.X SMTP Messages Pending Routing
             EXSPI-6.X SMTP Categorizer Queue Length
             EXSPI-6.X SMTP Local Queue Length
             EXSPI-6.X SMTP Local Retry Queue Length
             EXSPI-6.X Dc-SMTP Server Performance
             EXSPI-6.X Dc-SMTP Queues
             EXSPI-6.X SMTP NDR Percentage
             EXSPI-6.X SMTP Outbound Connections Refused
             EXSPI-6.X SMTP Remote Queue Length
             EXSPI-6.X SMTP Remote Retry Queue Length
             EXSPI-6.X Dc-SMTP Virtual Server Storage
             EXSPI-6.X-0082
             EXSPI-6.X-0083
             EXSPI-6.X-0084
             EXSPI-6.X-0085
             EXSPI-6.X-0086
             EXSPI-6.X-0087
             EXSPI-6.X SMTP Port Response
Tracking Log
             EXSPI-6.X Dc-TrackLog Data
             EXSPI-6.X Dc-TrackLog SLA Delivery
             EXSPI-6.X Dc-Message Tracking Log Space Usage
             EXSPI-6.X-0076

Exchange 2000
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Optional Exchange 
Server Roles

EXSPI Chat Service
             EXSPI-6.0-0836
             EXSPI-6.0-0835
             EXSPI-6.0 15m-Chat
             EXSPI-6.0-0834
             EXSPI-6.0-0833
             EXSPI-6.0-0831
             EXSPI-6.0-0830
             EXSPI-6.0 Dc-Chat Service Clients and Channels
EXSPI Conferencing Service
       EXSPI Conference Server
              EXSPI-6.0-0801
              EXSPI-6.0 10m-Conf
              EXSPI-6.0 Dc-ConfTrends
              EXSPI-6.0-0800
              EXSPI-6.0-0802
       EXSPI Conferencing Bridge
               EXSPI-6.0-0805
               EXSPI-6.0 10m-ConfBridge
               EXSPI-6.0-0807
               EXSPI-6.0-0806
EXSPI MCU Server
               EXSPI-6.0-0803
               EXSPI-6.0 10m-MCU
               EXSPI-6.0 Dc-MCU
               EXSPI-6.0-0804
EXSPI Instant Messaging
             EXSPI-6.0-0842
             EXSPI-6.0-0846
             EXSPI-6.0-0845
             EXSPI-6.0 Dc-Instant Messaging Enabled Users

Exchange 2000
Auto Deploy Groups Policies
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Exchange 2000 Manual Deploy policies

ovo Exchange SPI core Data Collection
             EXSPI-6.X exspi Agent Configuration
             EXSPI-6.X Messages
Exchange Discovery
             EXSPI-6.X Check Discovery
             EXSPI-6.X Exchange Service Discovery
             EXSPI-6.X Exchange Cluster Discovery SysLog

Exchange 2000 
Manual Deploy Groups Policies

Site Replication Service            EXSPI-6.X SRS Process Monitor
           EXSPI-6.X SRS Service
           EXSPI-6.X-0112
           EXSPI-6.X SRS Pending Synchronizations
           EXSPI-6.X SRS Data Space Usage
           EXSPI-6.X SRS Remaining Updates
           EXSPI-6.X-0113

Active Directory 
Connector Server

           EXSPI-6.X ADC Process Monitor
           EXSPI-6.X ADC Service
           EXSPI-6.X ADC Import Failure Rate
           EXSPI-6.X ADC Operation Failure Rate

Exchange 2000
Auto Deploy Groups Policies
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Exchange Server
 

Availability
             EXSPI-6.X Server State
             EXSPI-6.X Exchange Application Information
             EXSPI-6.X Exchange System Information
             EXSPI-6.X Exchange Application Warnings
             EXSPI-6.X Exchange System Warnings
Transaction Log
             EXSPI-6.X-0005
             EXSPI-6.X-0006
             EXSPI-6.X Transaction Log Storage Use
Message Delivery
             EXSPI-6.X End to End Message Ping
Client Accessibility
             EXSPI-6.X Client Message Read
             EXSPI-6.X Client MAPI Logon
             EXSPI-6.X Client Message Send

Exchange 2000 
Manual Deploy Groups Policies
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Manual deployment of Exchange 2000 and 2003 policies
Manual deployment of Exchange 2000 and 2003 
policies

By default, groups of Exchange SPI policies deploy automatically when relevant 
applications or services are discovered on managed nodes. The setting to automatically 
deploy policies when services are discovered can be turned off, and each group of policies 
be deployed manually. 

If manual deployment of policies is desired, use the Recommended Policy deployment 
tables in the Exchange SPI online Help, to determine which policy groups should be 
deployed to manage an Exchange server.

To deploy policies manually:

1 Select the desired policies. 

2 Right click and select All Tasks > Deploy on..... 

3 Select the nodes on which to deploy the policies. 

4 Select Launch....

Manual Deploy policy groups

There is also a Manual Deploy folder containing policies, located under Policy 
Management Policy Groups SPI for Exchange, and the relevant Exchange version. These 
folders contain policies requiring additional configuration or special circumstances for 
deployment. 
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Exchange 5.5 policies

Policy group prerequisites for Exchange 5.5  

Policy Group/ Subgroup Required Service Required Manual Configuration

EXSPI Discovery N/A • Create MSXSPI service account 
with correct permissions

• Modify the policy to include 
service account and password.

EXSPI Quick Start N/A N/A

EXSPI Add-Ons
EXSPI cc:Mail Connector cc:Mail Connector N/A

EXSPI Internet Mail Services Internet Mail Service 
(IMS)

N/A

EXSPI Lotus Notes Connector Lotus Notes Connector N/A

EXSPI News Service N/A N/A

EXSPI Advanced
EXSPI End-to-End Message 
Ping 

N/A • Create MSXSPI service account 
with correct permissions

• Create mailbox using MBOX 
Config tool (needs service account 
name and password)

• Configure EXSPI End-to-End 
Message Ping policy to set up 
server pairs

• Modify the policy to include user 
name and password

EXSPI Event Log Warnings & 
Information

N/A N/A
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Policy group descriptions for Exchange 5.5

Quick Start policies for Exchange 5.5

EXSPI Reporter Collection N/A • Create MSXSPI service account 
and password

• Modify policies to include user 
name and password

Policy Group/ Subgroup Required Service Required Manual Configuration

Policy Subgroup Description

EXSPI Directory Service Executes alarm metrics for problems detected in the Microsoft Exchange 
Directory service.

EXSPI Event Log Errors Monitors all errors (type = Error) in the Windows System Log.

EXSPI General Data 
Collection

Contains all standard data collection policies used to feed data into the data 
collector. The collected data can be graphed or used to generate reports.

EXSPI Information Store Executes alarm metrics for problems detected in the Exchange Information 
Store service.

EXSPI Internal Errors Open Message Interface policy for trapping EXSPI errors.

EXSPI Message Transfer 
Agent

Executes alarm metrics for problems detected in the Microsoft MTA 
service.

EXSPI Services and 
Processes

Monitors the availability of key Exchange services and processes.

EXSPI Transaction Log Monitors the size in MB of the Exchange transaction logfiles as well as the 
disk space used by the files. When size increases or available disk space 
decreases to specific defined values, messages with warnings appear in the 
message browser.
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Add-Ons policies for Exchange 5.5

Advanced policies for Exchange 5.5

Policy Subgroup Description

EXSPI cc:Mail Connector Executes alarm according to cc:Mail Connector metrics. Deploy on all 
Exchange servers containing the cc:Mail Connector.

EXSPI Internet Mail 
Services

Executes alarm metrics for the problems detected in Exchange Internet Mail 
service. Deploy on all Exchange servers containing IMS.

EXSPI Lotus Notes 
Connector

Executes alarms for Lotus Notes Connector metrics. Deploy on all Exchange 
servers containing the Lotus Notes Connector.

EXSPI News Service Executes alarm metrics for problems detected in the Exchange News service. 
Deploy on all Exchange 5.5 servers containing the Exchange News service.

Policy Subgroup Description

EXSPI End-to-End 
Message Ping 

Alarms on AND collects data for the End-to-End Message Ping policy

EXSPI Event Log 
Warnings/Information

Monitors all warnings and information messages in the Windows System 
Log. Is not typically deployed.

EXSPI Reporter Collection Feeds data into the OpenView data collector for use by OpenView reporter.
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Using Exchange 5.5 reports and graphs

Data collection for reports and graphs

In order to collect data for Exchange 5.5 reports and graphs, the data collection schedule 
policies for any particular service need to be deployed.

Configuring and deploying Reporter Collection policies

The Exchange SPI Reporter Collection policies need to be deployed to any Exchange 
server for which you wish reports. 

The following steps are outlined:

• Create Mailboxes.

• Modify the EXSPI Reporter Collection policies to include service account user name 
and password.

• Deploy Reporter Collection policies.

• Enable message tracking.
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Figure 6 Exchange 5.5 Reporter Collection policies location 

Task 1: Create mailboxes

See the procedure “Create mailboxes” on page 115.

Task 2: Modify the EXSPI Reporter Collection Policies to include the service 
account user name and password

For Exchange 5.5 servers you need to edit each of the EXSPI Reporter Collection policies 
in the EXSPI Advanced policy group by adding the service account user name and 
password, so that Exchange server system data is accessible. The EXSPI General Data 
Collector policies in the EXSPI Quick Start policy group do not need modification.
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To edit Exchange 5.5 Reporter Collection policies:

1 Open the OVO console and expand the Policy Management folder.

2 In the left pane select Policy groups > SPI for Exchange > Exchange 5.5 >EXSPI 
Advanced > EXSPI Reporter Collection policy group.

3 In the right pane right-click a Reporter Collection policy and select All Tasks > Edit.

4 In the dialog that appears, check the As User radio button, enter the name of the 
service account, check Specify Password and enter the service account password. 
See “Service account with special Exchange privileges” on page 135.

5 Click Save and Close.

6 Repeat these steps for each Reporter Collection policy in the group.

Task 3: Deploy Reporter Collection policies

1 In the OVO Manager console expand the Policy management > Policy groups 
folders to view policy groups.

2 Open SPI for Exchange > Exchange 5.5 > EXSPI Advanced to view the policy 
groups in the EXSPI Advanced folder.

3 In the EXSPI Advanced folder double-click the Reporter Collection policy 
sub-group and see the individual policies in the details pane. 

4 Select the Dc-Exchange Info policy, right-click and select All Tasks > Deploy on, 
check all the nodes and click OK. 

5 Other Reporter policies are deployed to servers depending on whether they host 
mailboxes or public folders. 

6 For servers which host mailboxes, select the Dc-TrackLog Data, Dc-Private IS Sum 
Data and Dc-Mailbox Data policies in the details pane, right-click and select All 
Tasks > Deploy on, then select all the servers which host mailboxes and click OK. 

7 For servers which host public folders, select the Dc-Public Folder Data and 
Dc-Public IS Sum Data policies in the details pane, right-click and select All Tasks 
> Deploy on, then select all the servers which host public folders and click OK.

Task 4: Enabling message tracking 

Exchange provides a message-tracking facility that stores processed message information 
in a log file. This information, which includes sender address, recipient addresses, and 
message size, is collected by the EXSPI-5.5 Dc-TrackLog Data collection policy. This 
policy must be deployed to all appropriate managed nodes. 
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Before deploying EXSPI 5.5 Dc-TrackLog Data collection policy you need to enable 
message tracking on your Exchange servers.

Enabling message tracking on Exchange 5.5 Servers

1 Select Start > Programs > Microsoft Exchange > Microsoft Exchange 
Administrator.

2 Expand the site level and Configuration to view selections beneath it.

3 In the details pane double-click Information Store Site Configuration.

4 In the Information Store Site Configuration Properties dialog, check Enable 
message tracking, and select OK.

Figure 7 Information Store Site Configuration dialog   

5 Repeat steps 3 and 4 for MTA Site Configuration.
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Figure 8 MTA Site Configuration dialog     

6 In the left pane select Connections.

7 In the right pane select Internet Mail Service, check the Enable message tracking 
checkbox, and press OK.

If the Internet Mail Service connector does not exist, skip the following steps.
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Time interval before generation of reports
Exchange SPI reports are not available until data has been gathered to the management 
server from the managed nodes. This occurs each night, so at least one day of activity is 
needed for the reports to populate. Where a report type requires data from a Sat/Sun 
collection, those reports will require a weekend prior to generation.

In addition, the SPI for Exchange Reports folder will not be created until data is collected 
on nodes and the Service Reporter consolidation process has run, which is usually 24 
hours after a node becomes managed.   

To display a report:

Select the desired report, right click.and select Show report.
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Exchange SPI reports

Exchange 2003 reports

Exchange SPI reports for Exchange 2003 are located on the OVO console under Reports 
and Graphs > Reports > SPI for Exchange 2000, in the following groups:

Client Access 

Exchange 2003 ActiveSync Usage 

Exchange 2003 ActiveSync Notifications 

Exchange 2003 and 2000 IMAP4 Connections

Exchange 2003 and 2000 MAPI Logon SLA 

Exchange 2003 and 2000 Message Read SLA 

Exchange 2003 and 2000 Message Send SLA 

Exchange 2003 and 2000 OWA Authentications

Exchange 2003 and 2000 OWA Connections

Exchange 2003 and 2000 OWA Usage 

Exchange 2003 OMA Sync Usage 

Exchange 2003 and 2000 POP3 Connections

Exchange 2003 and 2000 Messaging Ports 

Exchange Server 

Exchange 2000 and 2003 System Information Summary 

Information Store

Exchange 2003 and 2000 Full Text Indexing Stats   

Exchange 2003 and 2000 IS Users and Connections 

Exchange 2003 and 2000 Transaction Log Stats   

Mailbox Store 

Exchange 2003 and 2000 Inactive Mailboxes 
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Exchange 2003 and 2000 Mailbox Details 

Exchange 2003 and 2000 Mailbox Store Stats

Exchange 2003 and 2000 Mailbox Summary 

Exchange 2003 and 2000 Mailbox Store Msg Trends   

Exchange 2003 and 2000 Mailbox Usage Trends 

Exchange 2003 and 2000 Top 100 Mailboxes 

Messaging 

Exchange 2003 and 2000 All Local Msg Delivery SLA 

Exchange 2003 and 2000 MTA Msg Trends 

Exchange 2003 and 2000 MTA Queue Data Stats 

Exchange 2003 and 2000 SMTP Connections 

Exchange 2003 and 2000 SMTP Msg Trends 

Exchange 2003 and 2000 SMTP Virtual Server Stats

Exchange 2003 and 2000 Message Tracking Stats 

Exchange 2003, 2000, and 5.5 Top Destinations

Exchange 2003, 2000, and 5.5 Top Recipients 

Exchange 2003, 2000, and 5.5 Top Senders

Exchange 2003, 2000, and 5.5 Top Sources

Exchange 2003, 2000, and 5.5 Message Delivery SLA

Public Folder Store

Exchange 2003 and 2000 Folder Summary 

Exchange 2003 and 2000 Folder Usage Trends 

Exchange 2003 and 2000 Inactive Folders 

Exchange 2003 and 2000 Public Folder Store Stats 

Exchange 2003 and 2000 Public Folder Store Msg Tnd 

Exchange 2000 and 2003 Top 100 Public Folders 
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Exchange 2000 reports

Exchange SPI reports for Exchange 2000 are located on the OVO console under Reports 
and Graphs > Reports > SPI for Exchange 2000, in the following groups:

Chat

Exchange 2000 Chat Trends

Client Access

Exchange 2003 and 2000 IMAP4 Connections

Exchange 2003 and 2000 MAPI Logon SLA 

Exchange 2003 and 2000 MAPI Send SLA 

Exchange 2003 and 2000 Message Read SLA 

Exchange 2003 and 2000 OWA Authentications

Exchange 2003 and 2000 OWA Connections

Exchange 2003 and 2000 OWA Usage 

Exchange 2003 and 2000 POP3 Connections 

Exchange 2003 and 2000 Messaging Ports 

Conferencing 

Exchange 2000 Conferencing Server Trends

Exchange 2000 MCU Trends 

Exchange Server 

Exchange 2003 and 2000 System Information Summary 

Information Store

Exchange 2003 and 2000 IS Users and Connections

Exchange 2003 and 2000 Full Text Indexing Stats

Exchange 2003 and 2000 Transaction Log Stats 
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Instant Messaging    

Exchange 2000 Instant Messaging Availability Trends

Exchange 2000 Instant Messaging Users Growth

Mailbox Store 

Exchange 2003 and 2000 Inactive Mailboxes   

Exchange 2003 and 2000 Mailbox Details 

Exchange 2003 and 2000 Mailbox Store Stats 

Exchange 2003 and 2000 Mailbox Summary 

Exchange 2003 and 2000 Mailbox Store Msg Trends 

Exchange 2003 and 2000 Mailbox Usage Trends   

Exchange 2000/2003 Top 100 Mailboxes 

Messaging

Exchange 2003 and 2000 All Local Msg Delivery SLA 

Exchange 2003 and 2000 MTA Msg Trends 

Exchange 2003 and 2000 MTA Queue Data Stats 

Exchange 2003 and 2000 SMTP Msg Trends 

Exchange 2003 and 2000 SMTP Connections

Exchange 2003 and 2000 Message Tracking Stats    

Exchange 2003, 2000, and 5.5 Top Destinations 

Exchange 2003, 2000, and 5.5 Top Recipients 

Exchange 2003, 2000, and 5.5 Top Senders 

Exchange 2003, 2000, and 5.5 Top Sources 

Exchange 2003, 2000, and 5.5 Message Delivery SLA

Exchange 2003 and 2000 SMTP Virtual Server Stats 

Public Folder Store 

Exchange 2003 and 2000 Folder Summary 

Exchange 2003 and 2000 Folder Usage Trends
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Exchange 2003 and 2000 Inactive Folders 

Exchange 2003 and 2000 Public Folder Store Stats

Exchange 2003 and 2000 Public Folder Store Msg Tnd 

Exchange 2000/2003 Top 100 Public Folders 
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Exchange 5.5 reports

Exchange Server 

Exchange 5.5 System Information Summary 

Information Store 

Exchange 5.5 User Connections

Mailbox Database 

Exchange 5.5 Mailbox Details 

Exchange 5.5 Mailbox Summary 

Exchange 5.5 Mailbox Usage Trends 

Exchange 5.5 Top 100 Mailboxes 

Messaging 

Exchange 5.5 IMS Messaging Trends 

Exchange 5.5 Messaging Trends 

Exchange 5.5 Message Delivery SLA 

Exchange 2003, 2000 and 5.5 Top Destinations 

Exchange 2003, 2000 and 5.5 Top Recipients 

Exchange 2003, 2000 and 5.5 Top Senders

Exchange 2003, 2000 and 5.5 Top Sources 

Public Folder Database 

Exchange 5.5 Folder Summary 

Exchange 5.5 Folder Usage Trends 

Exchange 5.5 Top 100 Public Folders 
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Exchange SPI graphs
Exchange SPI comes with a set of preconfigured graphs. They are located on the OVO 
console tree in the Operations Manager > Reports and Graphs > Graphs folders. 

To display a graph:

Double click the desired graph and the Display graph associated with dialog opens:

Select the nodes to retrieve data from, the date range, and the level of granularity. Check to 
periodically update the data in the graph, or to use Java graphs.
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Figure 9 Example DSAccess Hit-Miss Ratio graph
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Exchange 2003 graphs

Exchange SPI comes with an array of preconfigured graphs. In the console tree, open 
Reports and Graphs > Graphs > SPI for Exchange 2003. Graphs are located in the 
following folders: 

• Client Access

• Directory Service

• Information Store

• Mailbox Store

• Messaging

• Public Folder Store

Client Access 

ActiveSync Performance: This graph shows the ActiveSync Microsoft Exchange 
active directory, connection, and pending requests. 

ActiveSync Users: This graph shows the current users of Microsoft Exchange 
ActiveSync. 

IMAP4 Connections: This graph shows the IMAP4 connection activity. 

IMAP4 Performance: This graph shows the IMAP4 transaction activity. 

MAPI RPC Latency levels: This graph shows the number of successful RPCs with 
Outlook client latency levels.

MAPI RPC Performance: This graph shows metrics of information store RPC 
requests and RPC operations rate (operations/sec). 

Number of Successful RPCs with Different Latency Levels: This graph shows the 
number of successful RPCs with different Outlook client latency levels. 

Outlook Client RPC Performance: This graph shows the Outlook Client RPC 
Performance. 

OWA Connections: This graph shows the OWA connection activity. 

OMA Response Time: This graph shows the MSExchangeOMA last response time 
in seconds. 

POP3 Connections: This graph shows the POP3 connection activity. 

POP3 Performance: This graph shows POP3 messages delivered to mailboxes. 
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Directory Service

DSAccess Cache Hit-Miss Ratio: This graph shows MSExchangeDSAccess cache 
hit and miss ratio for Exchange 2000 and 2003 servers.

Site Replication Service Space Free: This graph shows the percentage of free space 
on the Site Replication Service volume.

Site Replication Service Space Used: This graph shows Site Replication Service 
space usage on the Exchange server.

Information Store

Full-Text Indexing Space Usage: This graph shows disk space usage for full-text 
indexing of Microsoft Exchange information stores. 

Information Store Users and Connections: This graph shows user and connection 
count metrics, for the current day. 

Virtual Memory 16MB Free Block Trend: This graph shows information store 
virtual memory 16MB free block use trends. 

Virtual Memory Large Free Block Megabytes Usage: This graph shows 
information store virtual memory large free block megabytes usage. 

Virtual Memory Largest Block Size: This graph shows the change of the 
information store virtual memory largest block size. 

Transaction Log Percentage Free: This graph shows the percentage of free space on 
the transaction log volumes. 

Transaction Log Space Used: This graph shows Exchange server transaction log 
space usage on the Exchange server. 

Mailbox Store

Mailbox Store Delivery Time: This graph shows hourly metrics for the average 
delivery times of messages to Exchange server private and public mailboxes. 

Mailbox Store EDB Database Statistics: This graph shows Exchange server private 
mailbox store database statistics.

Mailbox Store Streaming Database Statistics: This graph shows Exchange mailbox 
store streaming database statistics.

Mailbox Store Storage Usage: This graph shows mailbox store storage usage.

Mailbox Store Message Volume: This graph shows Exchange server private mailbox 
volume.
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Mailbox Store Queues: This graph shows Exchange server mailbox store queue 
lengths.

Messaging

MTA Message Volume: This graph shows Exchange server Message Transfer Agent 
volume. 

MTA Queues: This graph shows Exchange server queue lengths. 

SMTP Connections: This graph shows SMTP virtual server connections on the 
Exchange server. 

SMTP Queues: This graph shows SMTP server queues on the Exchange server 

SMTP Message Volume: This graph shows SMTP volume on the Exchange server. 

SMTP Queue, Badmail, and Pickup Counts: This graph shows SMTP badmail, 
pickup and queue item counts for each SMTP virtual server. 

SMTP Queue, Badmail, and Pickup Size: This graph shows SMTP badmail, pickup 
and queue sizes for each SMTP virtual server. 

X400 MTA Queue Space Usage: This graph shows disk space usage for X400 
service MTA queue.

Public Folder Store

Public Folder Store Delivery Time: This graph shows hourly metrics for the average 
delivery times of local messages to Exchange servers. 

Public Folder Store EDB Database Statistics: This graph shows Exchange server 
public folder store (edb) database statistics. 

Public Folder Store Message Volume: This graph shows Exchange server public 
folder volume. 

Public Folder Store Streaming Database Statistics: This graph shows Exchange 
Public Folder store streaming database statistics. 

Public Folder Store Storage Usage: This graph shows Exchange server public folder 
usage. 

Public Folder Store Queues: This graph shows Exchange server public folder store 
queue lengths.
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Exchange 2000 graphs

Exchange 2000 graphs are arranged in the following service groups:

• Client Access

• Directory Service

• Information Store

• Mailbox Store

• Messaging

• Public Folder Store

Client Access

IMAP4 Connections: This graph shows the IMAP4 connection activity. 

IMAP4 Performance: This graph shows the IMAP4 transaction activity. 

MAPI RPC Performance: This graph shows metrics of information store RPC 
requests and RPC operations rate (operations/sec). 

OWA Connections: This graph shows the OWA connection activity. 

POP3 Connections: This graph shows the POP3 connection activity. 

POP3 Performance: This graph shows POP3 messages delivered to mailboxes. 

Directory Service

DSAccess Cache Hit-Miss Ratio: This graph shows MSExchangeDSAccess cache 
hit and miss ratio for Exchange 2000 and 2003 servers.

Site Replication Service Space Free: This graph shows the percentage of free space 
on the Site Replication Service volume.

Site Replication Service Space Used: This graph shows Site Replication Service 
space usage on the Exchange server.

Information Store

Full-Text Indexing Space Usage: This graph shows disk space usage for full-text 
indexing of Microsoft Exchange information stores. 

Information Store Users and Connections: This graph shows user and connection 
count metrics, for the current day. 
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Transaction Log Percentage Free: This graph shows the percentage of free space on 
the transaction log volumes. 

Transaction Log Space Used: This graph shows Exchange server transaction log 
space usage on the Exchange server. 

Virtual Memory 16MB Free Block Trend: This graph shows information store 
virtual memory 16MB free block use trends. 

Virtual Memory Large Free Block Megabytes Usage: This graph shows 
information store virtual memory large free block megabytes usage. 

Virtual Memory Largest Block Size: This graph shows the change of the 
information store virtual memory largest block size. 

Mailbox Store

Mailbox Store Delivery Time: This graph shows hourly metrics for the average 
delivery times of messages to Exchange server private and public mailboxes. 

Mailbox Store EDB Database Statistics: This graph shows Exchange server private 
mailbox store database statistics.

Mailbox Store Message Volume: This graph shows Exchange server private mailbox 
volume.

Mailbox Store Streaming Database Statistics: This graph shows Exchange mailbox 
store streaming database statistics.

Mailbox Store Storage Usage: This graph shows mailbox store storage usage.

Mailbox Store Queues: This graph shows Exchange server mailbox store queue 
lengths.

Messaging

MTA Message Volume: This graph shows Exchange server Message Transfer Agent 
volume. 

MTA Queues: This graph shows Exchange server queue lengths. 

SMTP Connections: This graph shows SMTP virtual server connections on the 
Exchange server. 

SMTP Message Volume: This graph shows SMTP volume on the Exchange server. 

SMTP Queues: This graph shows SMTP server queues on the Exchange server 
108



Chapter 4
SMTP Queue, Badmail, and Pickup Counts: This graph shows SMTP badmail, 
pickup and queue item counts for each SMTP virtual server. 

SMTP Queue, Badmail, and Pickup Size: This graph shows SMTP badmail, pickup 
and queue sizes for each SMTP virtual server. 

X400 MTA Queue Space Usage: This graph shows disk space usage for X400 
service MTA queue.

Public Folder Store

Public Folder Store Delivery Time: This graph shows hourly metrics for the average 
delivery times of local messages to Exchange servers. 

Public Folder Store EDB Database Statistics: This graph shows Exchange server 
public folder store (edb) database statistics. 

Public Folder Store Message Volume: This graph shows Exchange server public 
folder volume. 

Public Folder Store Streaming Database Statistics: This graph shows Exchange 
Public Folder store streaming database statistics. 

Public Folder Store Storage Usage: This graph shows Exchange server public folder 
usage. 

Public Folder Store Queues: This graph shows Exchange server public folder store 
queue lengths.
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Exchange 5.5 graphs

The Exchange 5.5 graphs are organized in the following categories:

Information Store 

Delivery: This graph shows hourly metrics for the average delivery times of 
messages to Exchange server private and public mailboxes.

Users: This graph shows information store user count metrics, for the current day.

Mailbox Database

Mailbox Usage: This graph shows Exchange server mailbox usage.

Private Mailbox Volume: This graph shows Exchange server private mailbox 
volume.

Messaging

Internet Mail Queue: This graph shows the Exchange server Internet Mail Service 
queue count. 

Internet Mail Volume: This graph shows Exchange server Internet Mail Connector 
volume. 

MTA Volume: This graph shows Exchange server Message Transfer Agent volume. 

Newsfeed Volume: This graph shows Exchange server newsfeed volume. 

Queues: This graph shows Exchange server queue lengths. 

Public Folder Database

Public Folder Usage: This graph shows Exchange server public folder usage.

Public Folder Database: This graph shows Exchange server public folder volume.
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Configuring Exchange SPI for 
Message Delivery SLAs

This chapter outlines procedures for: 

• Configuring and deploying End-to-End Message Ping to determine Service Level 
Agreement/Objective (SLA) performance for Exchange 2000 and Exchange 2003 
servers.

• Configuring and deploying End-to-End Message Ping to determine Service Level 
Agreement/Objective (SLA) performance for Exchange 5.5 servers
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Exchange 2000/2003: monitoring message 
delivery SLAs

Use the Exchange SPI End-to-End Message Ping to monitor message delivery SLAs. The 
End-to-End Message Ping procedure requires performing the following tasks:

• Create/specify a mailbox for each source Exchange 2000/2003 server where the 
policy will be deployed.

• Run the Exchange SPI End-to End Configuration wizard to create Service Level 
Agreement configurations for all managed Exchange 2000 or 2003 servers.

Task 1: Create a new source mailbox for each source server

A mailbox needs to be created on each OVO managed Exchange 2000 or Exchange 2003 
server from which the Ping messages will be sent out

1 In the OVO manager console, expand the Tools > SPI for Exchange > Exchange 
2000 and 2003 > End-to-End SLA Configuration folder.

2 In the details pane on the right, double click the MBOX Config tool

3 Select the servers the tool should launch on.

4 Launch the MBOX Configuration tool on the managed Exchange server to create a 
new user and associated mailbox with the default prefix ID. 

5 If you want to specify the organizational unit and mailbox prefix:

a Select the Parameters tab. By default the organizational unit is set to “Users”, 
and the default mailbox prefix ID is msxspi, so the user/mailbox name will be 
msxspi<server name>. 

b Create the mailbox name with a prefix ID, followed by the Windows hostname, 
with no spaces: <prefix ID><server name>, e.g. msxspi<server name>

c Select the Login tab. Enter the User name and password for a user who has the 
privilege to create Users with mailboxes in this domain.

d Click Launch.

Task 2: Run the End-to-End Configuration wizard to configure SLAs

1 In the OVO Manager console expand the Tools > SPI for Exchange > Exchange 
2000 and 2003 > End-to-End SLA Configuration folder.
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2 In the details pane on the right, double-click the End-to-End Configuration tool.

3 Confirm the introductory dialog, which gives an example of a typical SLA, by 
clicking Next.

4 Select the Exchange SPI configuration setting that best matches your SLA. Click 
Next.

5 Select the Source Servers from the list of OVO managed servers. A source server is a 
server from which email is sent, which is the server from which the SLA is 
determined. Click Next.

6 Select the Destination Servers from the list. These can be any Exchange servers 
within your organization, not only OVO managed Exchange servers. Click Next.

7 Specify the Service Level Agreement by assigning the thresholds (in seconds) for 
Timeout, Met SLA and Almost met SLA. 

8 Click Next.
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9 Confirm or make changes to the SLAs. Click Next.

10 Select to deploy all End-to-End Policies to the managed nodes. Only managed nodes 
configured to determine SLAs will send and receive mail. Note: This step can also be 
performed manually by deploying SPI for Exchange 200X instrumentation and the 
EXSPI End-to-End Message Ping policy (Manual Deploy Groups > Exchange 
Server > Message Delivery folder) to any desired managed nodes. 

11 Click Next.

12 Click Finish. Then OK.

Figure 10 Example SLA thresholds, where Met SLA=60, Almost met SLA=60, 
Time Out=300

The wizard has to be run whenever an Exchange server becomes an OVO managed 
server, if an SLA is to be monitored on the newly managed server.
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Exchange 5.5: monitoring message delivery 
SLAs

Use the EXSPI-End-to End Message Ping policy in the Exchange 5.5 EXSPI Advanced 
policy group, to determine SLA performance by sending and receiving messages.

The procedure to configure and deploy the EXSPI End-to-End Message Ping involves the 
following tasks:

1 Create a service account with special admin privileges, see “Creating a service 
account for Exchange 5.5 servers” on page 137.

2 Create a mailbox for the service account on every targeted Exchange server.

3 Set up the server connections to test message delivery and receipt.

4 Set up the Exchange SPI Message Ping alarms by configuring server pair thresholds.

5 Modify the EXSPI End-to-End Message Ping policy to include the service account 
user password.

6 Deploy the Configuration file and the EXSPI End-to-End Message Ping policy.

Task 1: Create a service account with special admin privileges

See “Creating a service account for Exchange 5.5 servers” on page 137.

Task 2: Create mailboxes

The service account needs a mailbox on every targeted Exchange server to access 
Exchange mailbox and folder information. 

To create a mailbox for the service account

1 In the OVO Manager console expand the Tools > SPI for Exchange > Exchange 5.5 
folder.

2 In the details pane on the right, double-click the MBOX Config tool.

3 Select the servers the tool should launch on.

4 Select Launch to start the tool running on the selected nodes.
115



Exchange 5.5: monitoring message delivery SLAs
5 When prompted, enter the service account user name and password.   

  

If you cannot automatically create mailboxes and receive an error, try to manually create a 
mailbox for each Exchange server with the prefix MSXSPI and NT hostname. For example, 
the node rosspidb5.rose.hp.com (Internet name) and NT name ROSSPIB5 require a 
mailbox called MSXSPIROSSPIDB5 with primary NT account MSXSPI. 
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Task 3: Set Up server connections to test message delivery/receipt 

The EXSPI-5.5- Ping Config policy in the EXSPI Advanced group tracks the round trip 
time of a message. Before deploying the policy, the servers you want to monitor must be 
added to this policy.

1 Open the policy Ping Config. 

2 Edit the text in the policy with your Exchange environment information. Only one 
policy is needed since you are able to designate at this level which server the 
configuration line is valid for. When finished, select Save and Close.  

Examples:

#     EXCH1::::MSXSPIEXCH2:25m:1m:1m 
#     EXCH1:MSXSPIEXCH1:::MSXSPIEXCH3:2h:5m:2m 
#     EXCH2:MSXSPIEXCH2:::MSXSPIEXCH4:1h:20m:10m 
#     EXCH3:MSXSPIEXCH3:::MSXSPIEXCH4:25m:5m:5m 

EXAMPLE:

Enter server information to replace each entry separated by a colon (:). Each 
uncommented line represents a Service Level Agreement configuration. 

# Format of the file:
# Src-Svr:Src-MB:::Dest-MB:Timeout:MetSLA:AlmostMetSLA 

# Src-Svr = Source Server (required) 

# Src-MB = Source Mailbox (optional)
Defaults to 'MSXSPI<host_name>'. 

# Reserved = Reserved for future use, leave empty 

# Reserved = Reserved for future use, leave empty 

# Dest-MB = Destination Mailbox (required) 

# Timeout = Timeout (required)
 (s-seconds, m-minutes, h-hours) 

# MetSLA = Met SLA time (require for reports)
 (s-seconds, m-minutes, h-hours) 

# AlmostMetSLA = Almost met SLA time (require for reports) 
(s-seconds, m-minutes, h-hours) 
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In the following example of Ping Config policy text: ServerA will use Mailbox 
"MSXSPIServerA" to send a message to mailbox MSXSPIServerB. Server A will ignore 
the information in the line that starts with ServerC. There should be no white spaces at the 
beginning of lines. Lines beginning with # are comments and are ignored:

ServerA:MSXSPIServerA:::MSXSPIServerB:2h:5m:2m

ServerC::::MSXSPIServerA:20h:1m:1m  

# End File # __________#   

Definitions of terms:

— Source Server (required) — The server that the ping originates from. Each 
server where Exchange SPI is distributed has the same file, so Exchange SPI can 
parse this file and use all lines where the Source Server matches the server where 
it is run from.

— Source Mailbox (optional) — The mailbox to send the mail from. If this is not 
included, a default account is used “MSXSPI<host_name>” where <host_name> 
is replaced with the name of the server.

— Destination Mailbox (required) — The mailbox to send the ping to. This field is 
usually the only required destination entry.

— Timeout (required) (s-seconds, m-minutes, h-hours) — If a sent message does 
not return in the defined timeout interval, EXSPI logs it as a failure and sends a 
message to the OVO management server. Failed messages are tallied in terms of 
count and percentage within a report. The timeout value must be larger than the 
values for MetSLA and AlmostMetSLA so that a returned message can be 
processed using these values. It may have Exceeded SLA even though it has not 
exceeded the timeout interval. A Failed/Timedout message occurs, therefore, 
only when the message does not return before the timeout period is exceeded.  

The minimum timeout value should be set slightly less than the collection 
interval. For example, if the collection interval for metric 1002 is 30 minutes 
(the default), the timeout should be set to at least 25 minutes. The logic is that 
because the next measurement occurs only every 30 minutes, you should 
allow up to that amount of time for any messages to return before “giving 
up” and generating a failure. If you keep the timeout value within the 
collection interval and the reply message does return, it can be processed as 
Met, Almost Met, or Exceeded as opposed to Failed/Timedout. 
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— MetSLA (required for reports) (s-seconds, m-minutes, h-hours) — If the round 
trip time is greater than this value, the message is logged as either Almost Met 
SLA or Exceeded SLA. This value is required if data is being sent to the 
Measurement Data Collector Agent DSI for reporting (-l option when running 
exspi.exe). It is optional if only using alarms.

— AlmostMetSLA (required for reports) (s-seconds, m-minutes, h-hours)  — If the 
round trip time is greater than the MetSLA value but less than or equal to 
MetSLA plus AlmostMetSLA, the message is logged as Almost Met SLA. 
Otherwise, when the round trip time is higher than MetSLA plus 
AlmostMetSLA, it is logged as Clearly Exceeded SLA. This parameter is 
required if data is being logged to the data collection Agent DSI (-l option when 
running exspi.exe), optional if only using alarms.  

Examples:

EXCH1::::MSXSPIEXCH2:25m:1m:1m
Use the default FROM mailbox of MSXSPIEXCH1. Message must return within 1 
minute to meet the SLA, 2 minutes to almost meet the SLA, and at over 25 minutes a 
failure/timeout is generated.

EXCH1:MAILBOXEXCH1:::MAILOXEXCH3:2h:5m:2m 
Message must return within 5 minutes to meet the SLA, 7 minutes to almost meet the 
SLA, and at over 2 hours a failure/timeout is generated.

EXCH2:MAILBOXEXCH2:::MAILOXEXCH4:1h:20m:10m
Message must return within 20 minutes to meet the SLA, 30 minutes to almost meet 
the SLA and at over 1 hour a failure/timeout is generated.

Timeout, MetSLA, and AlmostMetSLA values can have optional identifiers 
that denote the measurement units the value represents; for example, 4m (4 
minutes) 30s (30 seconds) or 1h (1 hour). The default unit is seconds; for 
example, the entry 4 by default is recognized as 4 seconds. 
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3 

4 
Task 4: Set Up EXSPI End-to-End Message Ping Alarms—configure server pair 
thresholds 

Alarms can be set to occur with metric 1002 (Ping). As you may need to set different 
thresholds for multiple server pairs, some examples are included here to clarify the 
procedure. These examples show the syntax to insert in the exspilnk.txt file to set differing 
thresholds. Metric 1002 sends the “FromMailbox,ToMailbox” in the object pattern fields 
with the following definitions:

FromMailbox = FromServer:FromMailbox

ToMailbox    = :ToMailboxl   

Requirement: When you configure server connections, you must start the EXSPI Admin 
tool EXSPI Ping Config from the OpenView management server. 

Config Entry Object 

EXCH1::::MSXSPIEXCH2:25m:1m:1m EXCH1:MSXSPIEXCH1,:MSXSPIEXCH2 

EXCH1:MAILBOXEXCH1:::

MAILOXEXCH3:2h:5m:2m 

EXCH1:MAILBOXEXCH1,:MAILOXEXCH

EXCH2:MAILBOXEXCH2:::

MAILOXEXCH4:1h:20m:10m 

EXCH2:MAILBOXEXCH2,:MAILOXEXCH
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Task 5: Modify the policy to include the service account password

Before deploying the EXSPI End-to-End Message Ping policy, you must edit it to include 
the service account name and password, so that it has access to data on the Exchange 
server system. 

To edit the policy:

1 Open the OVO console and expand the Policy Management folder.

2 In the left pane select Policy groups > SPI for Exchange > Exchange 5.5 > EXSPI 
Advanced > EXSPI End-to-End Message Ping group.

3 In the right pane right-click the EXSPI-5.5-End-to-End Message Ping policy and 
select All Tasks > Edit.

Condition Name & 
Type Condition Object Pattern Threshold Explanation

EXSPI-1002.1
+Message on
Matched Condition

EXCH1:MSXSPIEXCH1, 
:MSXSPIEXCH2

120 Threshold condition for ping 
between System EXCH1 and 
mailbox MSXSPIEXCH2 on 
system EXCH2. Object pattern is 
case sensitive.

EXSPI-1002.2
+Message on 
Matched Condition

EXCH1:MSXSPIEXCH1, 
:MSXSPIEXCH3

240 Threshold condition for ping 
between System EXCH1 and 
mailbox MSXSPIEXCH3 on 
system EXCH3. Object pattern is 
case sensitive.

EXSPI-1002.3
-Suppress 
Matched Condition

EXCH1:MSXSPIEXCH1, 
:MSXSPIEXCH2
EXCH1:MSXSPIEXCH1, 
:MSXSPIEXCH3

If the threshold was not exceeded 
for these two system pairs, you 
must suppress the message if 
either of these system pairs gets 
past 1002.1 or 1002.2.

EXSPI-1002.4
+Message on 
Matched Condition

60 A blank object pattern to catch all 
remaining system pairs.
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4 In the dialog that appears, confirm or enter the service account user name (MSXSPI), 
check the Specify Password check box, and enter the password you assigned to the 
service account.

5 Click Save and Close.

Task 6: Deploy the configuration file and the policy

1 In the OVO Manager console expand the folders Policy management > Policy 
groups > SPI for Exchange > Exchange 5.5 > EXSPI Advanced.

2 In the EXSPI Advanced folder double-click the Advanced policy sub-group you 
want to deploy. 

3 In the details pane where all the policies and/or configuration files are now listed, 
select the policies and/or configuration file needed, right-click, and select Deploy 
on....

4 In the Deploy policies on... dialog, select all nodes by clicking the check box next to 
Nodes, or select individual nodes by clicking the adjacent checkbox.
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Format of objects passed from the Exspi executable to the Metric 
1002 for End-to-End Message Ping

The executable exspi_e55.exe is used to pass objects to the monitoring Measurement 
Threshold Policy EXSPI-5.5-1002. This monitor evaluates the End-to-End Message Ping 
and is used to check if the Service Level Agreements (SLA) for the turnaround-time of a 
mail time are met. The executable passes a message back to the "Measurement Threshold" 
Policy to match on the Object name in the following format:

A:B:C:D:E:F 

The format has the following meaning:

– A is one of the strings: 
["SLAViolation"|"SLAWarning"|"Timeout"|"Undeliverable"].

– B is Source node.

– C is Source Mailbox.

– D is Destination Node.

– E is Destination Mailbox.

– F is one of the following, depending on A: [SLA Threshold|Warning 
Threshold|Timeout Threshold].

According to this format, the default policy has four rules that match on the Object A. 
According to the value of A, a message is created and sent to the OVO Message Browser.
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Comparison: End-to-End Message Ping for 
Exchange 5.5 v. Exchange 2000/2003

— The Exchange SPI End-to-End Message Ping for Exchange 2000 and Exchange 
2003 servers sends the ping message to the System Assistant account of a 
destination Exchange 2000/2003 server. Therefore, there is no need to configure 
a receiving mailbox. 

— In addition, the ping messages received by the System Assistant will be 
automatically deleted by the Exchange 2000/2003 server and do not need to be 
manually deleted from the receiving mailbox by the Exchange SPI user.
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Exchange SPI Clustering support
Using Exchange SPI in high availability environments

The Exchange SPI can be configured to accommodate cluster environments where 
fail-overs allow uninterrupted Exchange availability. 

Synchronized with the cluster environment, Exchange SPI monitoring can be made to 
switch off for the failed node and switch on for the active node. 

For recognizing clustered Exchange instances, Exchange SPI relies on XML configuration 
files. These files allow the OVO agent to automatically enable instance monitoring on the 
currently active node after disabling instance monitoring on the inactive node.

The Exchange SPI setup for a cluster environment requires the following steps: 

1 Add the nodes to be managed from the OVO Console.

2 Modify, if necessary, the Exchange SPI monitoring configuration file included with 
the Exchange SPI (msexchange.apm.xml).

3 Create the clustered application configuration file (apminfo.xml) that associates 
Exchange SPI-monitored instances (Exchange virtual servers), with their 
corresponding cluster resource groups.

4 Restart the agent on the managed node.

Task 1: Add the Exchange Cluster nodes to be managed from the OVO Console.

From the Configure Managed Nodes dialog box of the OVO Console, add the Exchange 
cluster nodes to be managed. This brings about the following:
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— The Exchange cluster is discovered and the service map is updated with the 
cluster topology.

— Auto Deploy Groups policies are deployed to these nodes. 

Task 2: Modify the Exchange SPI monitoring configuration file (if necessary)

The Exchange SPI includes a monitoring configuration file, (msexchange.apm.xml), 
which is an XML file that describes the policies that should be cluster-aware.

The (msexchange.apm.xml file works in conjunction with the clustered application 
configuration file (apminfo.xml) that you need to create for your Exchange cluster.

The purpose of the Exchange SPI msexchange.apm.xml file is to list all the 
Exchange SPI policies on the managed node, in order that these policies can be disabled/
enabled, as appropriate, for inactive/active managed nodes. 

Task 3: Create the clustered application configuration file

Apminfo.xml is an XML file that describes the cluster instances (Exchange virtual 
servers).

Apminfo.xml, working in conjunction with the Exchange SPI monitoring configuration 
file (msexchange.apm.xml), allows you to associate Exchange SPI monitored 
instances (Exchange virtual servers) with their associating cluster resource groups. As a 
result, when a resource group is moved from one node in a cluster to another node in the 
same cluster, monitoring stops on the failed node and starts on the new node.

To generate the content of this file:

a Launch the Exchange SPI Exchange Cluster Configuration tool on an Exchange 
cluster node, see “Exchange Cluster Configuration tool” on page 128.   

b Use the generated output to construct the apminfo.xml.

The Exchange SPI msexchange.apm.xml file is normally ready to use 
with no configuring. However, if you have renamed any policies, you need to 
modify the file accordingly. The file is in the SPI for Exchange 
instrumentation directory on the management server. After modifying this 
file, you need to redeploy the SPI for Exchange instrumentation to the 
Exchange nodes that are part of the Exchange cluster.
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c Save the completed apminfo.xml file on each node in the cluster in this 
directory:

<installation_directory>/Installed Packages
/{790C06B4-844E-11D2-972B-080009EF8C2A}/conf/OpC/ 

Task 4: Restart the agent on the managed node

After constructing and saving apminfo.xml, stop and restart the OVO agent by running 
the following commands on each node: 

opcagt -kill
opcagt -start 

Example apminfo.xml file

The following is an example apminfo.xml file, where ExchResGroup1 and 
ExchResGroup2 are the names of the Exchange resource groups 
corresponding to EXCHVIRTSERV1 and EXCHVIRTSERV2 instances (virtual 
servers):

<?xml version="1.0" ?>
<APMClusterConfiguration>
  <Application>
    <Name>msexchange</Name>
      <Instance>
         <Name>EXCHVIRTSERV1</Name>
         <Package>ExchResGroup1</Package>
       </Instance>

<Instance>

<Name>EXCHVIRTSERV2</Name>
         <Package>ExchResGroup2</Package>
       </Instance>

  </Application>
</APMClusterConfiguration> 
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Figure 11 Example Exchange resource group   

Exchange Cluster Configuration tool

Use the Exchange Cluster Configuration tool to generate the content of the 
apminfo.xml file.

Launch this tool on an Exchange cluster node:

1 In the OVO Manager console expand the Tools > SPI for Exchange > Exchange 2000 
and 2003 > ovo Utilities folder.
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Figure 12 Location of Exchange Cluster Configuration tool

2 In the details pane on the right, double click the Exchange Cluster Configuration tool.
3 Select the Exchange cluster node the tool should launch to.
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Figure 13 Select nodes dialog

4 Select Launch to start the tool running on the selected nodes.
5 Use the generated output to construct the apminfo.xml. (Please refer to the 

section “Create the clustered application configuration file” on page 126). 

After constructing and saving apminfo.xml, you need to restart the agent on the node, 
using the following commands:

Opcagt -kill

Opcagt -start
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Figure 14 Example output of Cluster Configuration tool
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Data Collection on virtual servers

In order for reports and graphs to show data for any nodes, appropriate data collection 
policies need to be deployed to those nodes. See the section “” on page 134.

Run the Enable Message Tracking tool on all nodes in the cluster before deploying the 
EXSPI 6.X Dc-TrackLog Data policy, so that the tracking log reports will generate. The 
tool must run on the physical nodes of a cluster where the Exchange virtual server is 
running.

Seeing virtual servers in reports and graphs

The Exchange SPI will show Exchange virtual servers in reports and graphs as though 
they were physical Exchange servers.

Setting up End-to-End Message Ping on an Exchange 
Cluster

Using Exchange SPI, End-to-End Message Ping can be configured on Exchange clusters. 

1 Run the MBox Config tool on all nodes in the cluster. The tool must run on the 
physical nodes of a cluster where the Exchange virtual server is running on. This is a 
necessary step for configuring and deploying End-to-End Message Ping. 

2 Run the End-to-end Configuration (wizard) tool to add the Exchange virtual server 
to the end-to-end configuration. Exchange virtual server names will appear in the 
Source Server and Destination Server fields. Please see “Configuring Exchange SPI 
for Message Delivery SLAs” on page 111.

Exchange Cluster Service Map

Exchange clusters are represented in the Service Map, and Service map nodes will be 
created in the service map for each Exchange virtual server in a cluster. Since the cluster is 
properly modeled in the service map, Exchange SPI instrumentation and Quick Start 
policies are auto-deployed to all managed Exchange cluster nodes.

Messages for the Exchange virtual server show up under the Exchange virtual server name 
in the maps.
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For the Exchange Virtual server an EXSPI service discovery hosted-on hierarchy is 
created within a Clusters container. This allows messages to be sent to the hosted-on 
hierarchy. 

This same hierarchy is also created as virtual nodes under the Exchange Virtual Server. A 
dependency is created from each Virtual Exchange Server virtual node to its 
corresponding Cluster hosted-on node. Messages and status will then propagate up to the 
correct Virtual Exchange Server virtual node.

Figure 15  Service Map illustrating clustering support 

In the example above, there are two Virtual Exchange servers: EXCHVIRTSERV1 and 
EXCHVIRTSERV2, hosted on physical nodes OVRNTTC1B and OVRNTTC1A. A 
message is received at hosted-on service OVRNTTCLA:Queue, and via dependencies, 
status and messages are seen under Virtual server EXCHVIRTSERV2.
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What happens during a failover:

When a failover happens, dependencies to the failed node will be removed and replaced 
with new dependencies to the newly active node. For example, if EXCHVIRTSERV1 
moves from OVRNTTC1B to OVRNTTC1A, the dependencies to OVRNTTC1B will 
automatically be removed and will be replaced with a new set of dependencies to 
OVRNTTC1A..

When a failover happens, messages that occurred before the failover will not be 
propagated to the virtual node

For this mechanism to work EXSPI-6.0 Exchange Cluster Discovery Event Log policy 
must be deployed (normally auto-deployed).
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Exchange 5.5 user privileges
This chapter outlines procedures for creating a service account with special Exchange 
privileges for Exchange 5.5 in a Windows NT or Windows 2000 domain.

For Exchange 2000 and 2003, the recommended configuration for the Exchange SPI is: 

• running the OVO agent under the user context as Local System. 

Should this not be possible in your organization, see Appendix C for details on how to 
create a privileged service account for Exchange 2000 or 2003 nodes in a Windows 2000 
environment.

Service account with special Exchange privileges

This type of account must be set up for the following Exchange 5.5 tools/policies to 
deploy successfully:

• MBOX Config tool.

• The Service Discovery policy requires the User name and Password of this service 
account.

• Many of the policies in the Add-Ons group require the service account user name and 
password, before they can be deployed.

• Exchange 5.5 > EXSPI Advanced > EXSPI End-to-End Message Ping > EXSPI-5.5 
End-to-End Message Ping, schedule policy requires access to the mailboxes created 
by the tool MBOX Config.
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• Exchange 5.5 > EXSPI Advanced > EXSPI Reporter Collection > all policies. These 
policies use the Mailbox created by the tool MBOX Config, to extract information 
from the public folder and mailbox tables via MAPI (Messaging Application 
Programming Interface).
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Creating a service account for Exchange 5.5 
servers

For Exchange 5.5 servers, before you can deploy the above listed policies and tools, you 
must create an account for each Windows domain where OVO managed Exchange servers 
reside. This service account enables the Exchange SPI to access information from the 
Exchange database. 

Because significant configuration details vary according to operating system version, 
detailed instructions are outlined for the following environments:

• Case 1: For Nodes running Exchange 5.5 in a Windows NT Domain (NT4/Ex5.5)

• Case 2: For Nodes running Exchange 5.5 in a Windows 2000 Domain (W2k/Ex5.5)

Case 1: Exchange 5.5 nodes in a Windows NT Domain (NT4/
EX5.5)

Task 1: Create service account (NT4/EX5.5) 

1 Log on as Domain Administrator of the domain to which the Exchange server 
belongs. 

2 Select Start > Programs > Administrative Tools (common) > User Manager for 
Domain.

3 Select User > New User. In the dialog that appears create a new user as follows:
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Figure 16 User Manager dialog 

Remember this password; you will need it later to update Tools and Policies.  

Username: MSXSPI

Full Name: OVO Exchange SPI 

Description: Exchange SPI for OVO 

Password/Confirm Password: *********

You must create a service account with these privileges in each Windows domain. You must name 
the account MSXSPI. Throughout this document you will notice that the account is referred to as 
MSXSPI, which is the required user name for the service account.
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Figure 17 New User dialog     

4 Deselect User Must Change password at Next Logon and select Password Never 
Expires.

5 Click the Groups button to display the Group Memberships window.

This password must be entered but will not be authenticated later. 
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Figure 18 Group Memberships window

6 At the right, from the Not a member of: box select the Domain Admins user, click 
Add, and OK to close the Group Memberships window.

7 To include necessary information, click buttons in the New User window:    

8 Click Add to add this user. (If the Exchange Add Mailbox window is displayed, 
select Cancel to close it).

9 Click the Close button to close the New User window.

Profile: No User Profile should be specified.

Hours: All hours of the day and week should be allowed.

Logon To: All workstations should be specified.

Account: Should never expire/should be Global Account.
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10 From the User Manager menu bar select Policies > User Rights....

Figure 19 User Manager window

11 Check the Show Advanced User Rights checkbox.

12 From the drop-down list select Log on as a service in the Right field
141



Creating a service account for Exchange 5.5 servers
Figure 20 Selecting Log on as a service for User Rights.

13 Click the Add button to open the Add Users and Groups window.

14 Click the Show Users button.

15 Select the service account just added, click Add, then OK.
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Figure 21 Adding the new service account

16 Repeat steps 12-15 to add the Profile system performance right.

Task 2: Grant Exchange access permissions to service account (NT4/EX5.5)

In order for the service account to have access to a mailbox as well as the Exchange IS 
Public and Private databases, it must have Exchange Admin permissions. Use Exchange 
Administrator to grant these permissions at the site level.

1 Select Start > Program > Microsoft Exchange > Microsoft Exchange 
Administrator.

2 For each Exchange site where the affected policies are to be deployed:

a In the left pane within the tree, select <site_name>.

b From the File menu select Properties.
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c In the Properties window, select the Permission tab and click Add to open the 
Add Users and Groups window.

d Select the MSXSPI service account previously created, and click Add.

e Click OK to add the user, and close the Add Users and Groups window.

f Verify the user has the role of Admin.
144



Chapter 7
Figure 22 Verifying the User role

g Click OK to save the changes.
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Case 2: Exchange 5.5 nodes in a Windows 2000 domain 
(W2k/EX5.5)

Task 1: Create service account (W2k/EX5.5)

1 Log on to the system that hosts the managed node’s domain.

2 Select Start > Programs > Administrative Tools > Active Directory Users and 
Computers.

3 Expand the Active Directory of Users and Computers and right-click Users and select 
New User.

Figure 23 Selecting New User dialog
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4 In the dialog box that appears, enter a user name for the service account in the First 
Name and as the User logon name fields.  

Figure 24 New object dialog

5 In the next window, enter Password/Confirm Password for the service account.

6 Select Password Never Expires. Then click Next

You must create a service account with these privileges in each Windows domain. You 
must name the account MSXSPI. Throughout this document you will notice the account 
is referred to as MSXSPI, the required user name for the service account.
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Figure 25 Setting user privileges.

7 In the New Object dialog, deselect Create an Exchange mailbox, and click Next.
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Figure 26 Creating an Exchange Mailbox

8 In the next dialog, complete creating the user by clicking Finish.

9 You are now back at the Active Directory Users and Computers dialog. In the right 
pane, right-click on the user just created and select Properties.

10 On the service account Properties page, select the General tab. Enter OVO Exchange 
SPI in the Display name and Description fields.
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Figure 27 Properties dialog
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11 Select the Member Of tab. Click Add.
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12 In the Select Group dialog select Domain Admins from the top pane. Click Add, 
then OK.

13 The new user is now a member of the Domain Admins group. Click OK and exit the 
Active Directory Users and Computer dialog.

Figure 28 New User with new membership status 
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Task 2: Grant Exchange access permissions to service account (W2k/EX5.5)

In order for this service account to have access to a mailbox as well as the Exchange IS 
Public and Private databases, it must have certain Exchange Admin permissions. Use 
Exchange Administrator to grant these permissions at the site level.

1 Select Start > Program > Microsoft Exchange > Microsoft Exchange 
Administrator.

2 For each Exchange site where affected policies are to be deployed:

a In the left pane within the tree, select <site_name>.

b From the File menu select Properties.

c In the Properties window, select the Permission tab and click Add to open the 
Add Users and Groups window.

d Select the MSXSPI service account just created, and click Add.

e Click OK to add the user, and close the Add Users and Groups window.

f Verify the user has the role of Admin.
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Figure 29 Verifying User roles.

g Click OK to save the changes.
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Customizing policies and uninstalling 
the Exchange SPI

This chapter outlines the procedures for:

• Customizing policies and groups of policies

• Uninstalling the Exchange SPI

Customizing policies using the tag feature
If you have servers dedicated to specific sites or business units, you may find it effective 
for those servers to have uniquely named Exchange SPI policies. In such cases copy 
default policies into new groups, affix prefixes to the original names and include them in 
the schedule policy that collects data during that measurement interval. The procedure 
below gives you an example of how you might do this.

Task 1: Create the new policy group 

1 In the OVO console, expand the Policy management > Policy Groups folders.

2 Right-click the folder in which you want to locate the new group and select New > 
Policy Group.
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Figure 30 Creating a new policy group 

3 Enter the new group name for the folder created and click Enter.

4 In the console, use Shift+click or Ctrl+click to select the default policies to be in the 
group, right-click and select Copy.  

Remember to always copy scheduled task policies from the default policy 
group containing the measurement threshold policy you are copying to the 
new policy group. The scheduled task policy is necessary for any data 
collection to occur. 
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5 Right-click the new group you just created and click Paste.

6 The copied policy will be pasted into the new Policy group.

7 If you copied an entire group of default policies into the new group, you can eliminate 
those you do not need by right-clicking them and selecting Delete.

Task 2: Tag the policies

To designate these policies as a specific group, use a special prefix

1 Double-click each policy and make any changes to the policy desired. 

2 Select File > Save As. In the dialog that appears enter the special prefix followed by a 
hyphen in front of the default policy name; for example EuroSales-EXSPI-6.X IS 
Mailbox Average Delivery Time.
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Figure 31 Customizing a policy 

3 After saving any renamed policies, double-click the scheduled task policy that you 
copied to the new group together with the other policies. (In the example EXSPI-6.X 
Id-Dc-Instant Messaging is used.)

4 In the Command* text box at the end of the text, insert the tag (-t) parameter and the 
<prefix>- 

For example, to ensure data collection for all the policies renamed with the prefix 
EuroSales the Command text box would appear as shown in the figure below: 
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Figure 32 Example of an edited Command 

5 When finished, rename the scheduled task policy to include the group prefix, in this 
way: 

Select File > Save As and rename the EXSPI-6.X Id-Dc-Instant Messaging scheduled 
task policy to EuroSales-EXSPI-6.X Id-Dc-Instant Messaging.
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Figure 33 Renaming policy 

The prefix attached to the beginning of each policy in the new group makes the policies 
easy to find in the Policies grouped by type folder in the console. Also, creating a new 
group for the new policies gives you an efficient means to deploy them (right-click the 
group and select All Tasks > Deploy on...). Please see the online Help for more details.
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Uninstalling Exchange SPI
You may wish to remove the Exchange SPI from an OVO managed node, or uninstall the 
Exchange SPI from both the management server and the managed node/s. In both cases 
the first step is to remove Exchange SPI policies from managed node/s. 

1 Remove Exchange SPI policies from managed node/s

For the more complete uninstall, removing the Exchange SPI from both the management 
server and the managed node/s, follow these additional steps:

2 Delete Exchange SPI policy groups from management server.

3 Delete Exchange SPI tools from management server.

4 Delete customer versions of factory policies.

5 Uninstall Exchange SPI programs from the management server

For any uninstall of Exchange SPI:

Task 1: Remove Exchange SPI policies from all managed nodes

1 On the OVO console tree, expand the folders HP OpenView > Operations Manager 
> Policy Management > Policy groups > SPI for Exchange.

2 Right-click the SPI for Exchange, select All Tasks > Uninstall from...

3 In the “Uninstall Policies on” dialog, select All Nodes.

4 Click OK.

Uninstalling Exchange SPI from the management server:

Task 2: Delete Exchange SPI policy groups from the management server

1 On the OVO console tree select and expand the folder Policy Groups.

2 Right-click SPI for Exchange and select Delete.

Note: If there are any customized policies on the node/s, remove them from their location.
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Task 3: Delete Exchange SPI tools from the management server

1 On the OVO console tree right-click Tools and select Configure > Tools.

2 In the “Configure Tools” dialog right-click SPI for Exchange and select Delete.

Task 4: Delete Exchange SPI customized policies from the management server

1 Navigate to Polices grouped by type.

2 For each Policy type group, right-click the group and select Set Filter....

3 Select the radio button All versions of the policy below, and click OK.

4 Sort policies by name in the list box. Select all Exchange SPI policies.

5 Right click and select All tasks > Delete from server.

6 Repeat for all policy groups.

Task 5: Uninstall Exchange SPI programs from the management server

1 Insert the Smart Plug-ins, New and Upgraded, CD for OpenView Operations/
Performance for Windows Version A.0.7.5, CD Volume 1.

2 Follow instructions as they appear. Start the uninstall procedure by selecting the 
Remove products radio button. 

3 In the Product Selection Uninstall window select Microsoft Exchange Server 
(SPI) and click Next.

4 In the next window, select Remove. (You are updated on the progress of the program 
removal).

5 Click Finish to complete the uninstall.
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Appendix A
Exchange SPI Instrumentation Files

EXSPI Exchange Discovery Instrumentation

Exchange 200X EXSPI Instrumentation

EXSPI_CreateServices.js Discovers hosted on Services

msexchange.apm.xml Cluster support file, identifies policies to 
enable/disable

OvExchDisc.exe Discovers virtual Services

exspi_RunDiscovery.js Resource group identification for 
rediscovery after a cluster failover

exspi_e2k.exe Collector used through schedules

exspidatasource.exe Creates database schema

EXSPI*.spec Database schema definitions

ovam*.dll Tracking log collection library

hpudm.txt Metric definitions

exspitra.vbs Turn Exchange SPI data collection tracing 
on and off

exspi_tracklog.vbs Turn Exchange tracking log file generation 
on
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exspi_e2k_cfg Create mailbox

exspi_dbmount.vbs Checks mount/dismount Information Store

exspi_StartService.vbs Starts a service

end-to-end.xml End-to-End Config file. This file exists after 
the execution of End-to-End Config tool

exspi_e2k_clust_config.js For Cluster Configuration

spi_msexch*.*

shs*.*

Self healing Service support files

exspi_ports.exe Determines if SMTP, HTTP, POP3, and 
IMAP4 ports are responding

exspi_checkMemCfg.wsf

exspi_checkMemoryConfig.vbs

exspi_cMemoryConfig.vbs

Check memory settings for Exchange 
Mailbox and public Folder Servers

exspi_e2k_tlog.js

exspi_e2k_tlog.vbs

exspi_e2k_tlog.wsf

exspi_e2k_tlog_lib.vbs

Used for gathering tracking log data. 
(Average delivery time for email sent on 
current server).

exspi_cml_cfg.wsf

exspi_cmr_cfg.wsf

exspi_cms_cfg.wsf

Tools for creating Mapi client SLA values.

exspi_agent.vbs

exspi_core.vbs

Shared scripts with agent functions

exspi_e2k_client_lib.vbs Shared script for Client response time 
scripts
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Appendix A
Exchange 5.5 EXSPI Instrumentation

exspi_e2k_cmr.vbs

exspi_e2k_cmr.wsf

Mapi Client Message Read response time 
scripts

exspi_e2k_send.vbs

exspi_e2k_send.wsf

Mapi Client Message Send response time 
scripts

exspi_e2k_logon.vbs

exspi_e2k_logon.wsf

Mapi Client Message Logon response time 
scripts

exspi_e55.exe Collector used through schedules

exspidatasource.exe Creates EPC database schema

EXSPI*.spec Database schema definitions

ovam*.dll Tracking log collector libraries

hpudm.txt Metric definitions

exspitra.vbs Turn Exchange SPI data collection tracing 
on and off

exspi_e55_cfg.exe Create mailbox

spi_msexch*.*

shs*.*

Self healing Service support files
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Appendix B
Service Reporter schema

In all EXSPI Reporter database tables, the first five columns have to be ID, 
SYSTEMNAME, DATETIME, GMT, SHIFTNAME, and in that order. No EXSPI data 
can be gathered if the first five column names or their order are different from this.
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EXSPI_PFSUMMARY
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INTERVAL_KEY
     SERVER_NAME
     ADMINGROUP
     STORAGEGROUP_NAME
     DATABASE_NAME
     EDBPATH
     STMPATH
     EDBSIZE
     STMSIZE
     EDBFREE
     STMFREE
     EDBTOTAL
     STMTOTAL
     PFLOGICALSIZE
     FOLDER_MSGCNT
     FOLDER_COUNT
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EXSPI_PFPERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_NAME
     SERVER_NAME
     PFDELIVERYTIME
     PFDELIVER
     PFSENT
     PFSUBMITTED
     PFRECIPIENT
     PFACTIVELOGON
      PFLOGON
      PFLOGONPEAK
      PFSIRATIO
      PFRECOVERITEMS
      PFRECOVERSIZE
      PFREPRCVD
      PFREPSENT
      PFREPQ

EXSPI_MBDETAIL
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INTERVAL_KEY
     SERVER_NAME
     STORAGEGROUP_NAME
     DATABASE_NAME
     MAILBOX_NAME
     MAILBOX_SIZE
     MAILBOX_QUOTA
     MAILBOX_MSGCNT
     MAILBOX_LASTACCESS
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EXSPI_MBSUMMARY
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INTERVAL_KEY
     SERVER_NAME
     ADMINGROUP
     STORAGEGROUP_NAME
     DATABASE_NAME
     EDBPATH
     STMPATH
     EDBSIZE
     STMSIZE
     EDBFREE
     STMFREE
     EDBTOTAL
     STMTOTAL
     MBLOGICALSIZE
     MAILBOX_USRCNT
     MAILBOX_MSGCNT
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EXSPI_MBPERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCEL_NAME
     SERVER_NAME
     MBDELIVERYTIME
     MBLOCALDELIVER
     MBDELIVER
     MBSENT
     MBSUBMITTED
     MBRECIPIENT
     MBACTIVELOGON
     MBLOGON
     MBLOGONPEAK
     MBSIRATIO
     MBRECOVERITEMS
     MBRECOVERSIZE
     MBSIRATIO

EXSPI_TRANSLOG
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INTERVAL_KEY
     SERVER_NAME
     STORAGEGROUP_NAME
     TRANSLOGFILEPATH
     TRANSLOGFILESIZE
     TRANSLOGFILEFREE
     TRANSLOGFILETOTAL
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EXSPI_OMA
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     OMASENT
     OMAIGNORE
     OMADISCARD
     OMARESPONSE

EXSPI_ASYNC
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     EXSPI_ASYNC
     ASYNCSENDMAIL
     ASYNCCMDS
     ASYNCCLIENTITEMS
     ASYNCSERVERITEMS
     ASYNCAD
     ASYNCCONNECT
     ASYNCPENDING
     ASYNCUSERS

EXSPI_ASNOTIFY
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     ASNTOTAL
     ASNSENT
     ASNIGNORE
    ASNDISCARD
     ASNEXPIRED
     ASNBIFURCATED
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EXSPI_SMTPPERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     SMTPMSGSENT
     SMTPMSGRECEIVE
     SMTPBYTESENT
     SMTPBYTERECEIVE
     SMTPMSGBYTESENT
     SMTPMSGBYTERECEIVE
     SMTPINBOUNDCON
     SMTPOUTBOUNDCON
     SMTPOUTBOUNDCONREF

EXSPI_IMAP4PERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     IMAP4CON
     IMAP4FAILEDCON
     IMAP4REJECTEDCON
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EXSPI_ISPERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     ISUSERCNT
     ISACTIVEUSERCNT
     ISANONUSERCNT
     ISACTIVEANONUSERCNT
     ISCONNECTCNT
     ISACTIVECONNECTCNT

EXSPI_MTAPERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     MTAMSGIN
     MTAMSGOUT
     MTARCPIN
     MTARCPOUT
     MTABYTESIN
     MTABYTESOUT

EXSPI_PORTS
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     PORT_NAME
     PORT_NUMBER
     SERVICE_PROVIDER
     SENT_BYTE
     RECV_BYTE
     RESP_TIME
     CONGFIG_TIMEOUT
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EXSPI_MTADATA
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME 
     INSTANCE_NAME
     MTADATABASEPATH
     MTADATABASESIZE
     MTADATABASEFREE
     MTADATABASETOTAL
     MTADATABASEFP

EXSPI_SMTPDATA
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     INSTANCE_NAME
     SMTPBADMAILDIR
     SMTPBADMAILSIZE
     SMTPBADMAILCNT
     SMTPBADMAILFREE
     SMTPBADMAILTOTAL
     SMTPBADMAILFP
     SMTPPICKUPDIR
     SMTPPICKUPSIZE
     SMTPPICKUPCNT
     SMTPPICKUPFREE
     SMTPPICKUPTOTAL
     SMTPPICKUPFP
     SMTPQUEUEDIR
     SMTPQUEUESIZE
     SMTPQUEUECNT
     SMTPQUEUEFREE
     SMTPQUEUETOTAL
     SMTPQUEUEFP
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EXSPI_MTLDATA
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     MTLPATH
     MTLSIZE
     MTLCNT
     MTLFREE
     MTLTOTAL
     MTLFP

EXSPI_OWAFE
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_NAME
     OWACONNECTIONS
     OWAMAXCONNECTIONS

EXSPI_OWABE
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_NAME
     SERVER_NAME
     OWAMSGSSENT
     OWAMSGSOPEN
     OWAAUTHS
     OWAAUTHSCACHE
     OWARECENTAUTHS
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EXSPI_FTIDATA
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     INSTANCE_NAME
     FTILOCATION
     FTISIZE
     FTIFREE
     FTITOTAL
     FTIFP
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EXSPI_SINGLE
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     IMC_IN_MSGS_TOT
     IMC_OUT_MSGS_TOT
     IMC_TOT_IN_KB
     IMC_TOT_IN_RCPIPNTS
     IMC_TOT_MSGS_QUEUED
     IMC_TOT_OUT_KB
     IMC_TOT_OUT_RCPIPNTS
     IS_ACTIVE_USER_CNT
     IS_NEWS_MSGS_RECV
     IS_NEWS_MSGS_SENT
     IS_NEWS_NNTP_POSTED
     IS_NEWS_NNTP_READ
     IS_PRIV_AVG_DEL_TIME
     IS_PRIV_AVG_LOC_DEL
     IS_PRIV_RECV_QUEUE
     IS_PRIV_SEND_QUEUE
     IS_PUB_AVG_DEL_TIME
     IS_PUB_AVG_LOC_DEL
     IS_PUB_RECV_QUEUE
     IS_PUB_SEND_QUEUE
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     IS_USER_CNT
     VERSION
     RESERVE1
     RESERVE2
     MTA_IN_BYTES_TOT
     MTA_IN_MSGS_TOTAL
     MTA_OUT_BYTES_TOT
     MTA_OUT_MSGS_TOTAL
     MTA_Q_LEN
     MTA_TOT_RCPIPNTS_IN
     MTA_TOT_RCPIPNTS_OUT
     PRIV_FREE_MB
     PRIV_IS_INST_RATIO
     PRIV_IS_LOC_DELIV
     PRIV_IS_LOG_DB_SIZE
     PRIV_IS_MSG_RCPT_DLV
     PRIV_IS_MSGS_DELIV
     PRIV_IS_MSGS_SENT
     PRIV_IS_MSGS_SUB
     PRIV_IS_TOTAL_MBOXES
     PRIV_IS_TOTAL_MSGS
     PUB_FREE_MB
     PUB_IS_INST_RATIO
     PUB_IS_LOG_DB_SIZE
     PUB_IS_MSG_RCPT_DLV
     PUB_IS_MSGS_DELIV
     PUB_IS_MSGS_SENT
     PUB_IS_MSGS_SUB
     PUB_IS_TOTAL_FOLDERS
     PUB_IS_TOTAL_MSGS

EXSPI_SINGLE
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EXSPI_MULTI
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE
     INTERVAL_KEY
     METRIC_ID
     VALUE
     VALUE_ID
     SERVER_NAME

EXSPI_M0660
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     COUNTER_0660
     INSTANCE_0660
     NUM_BYTES_0660
     NUM_MSGS_0660
     SERVER_NAME

EXSPI_0661
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     COUNTER_0661
     INSTANCE_0661
     NUM_BYTES_0661
     NUM_MSGS_0661
    SERVER_NAME
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EXSPI_0662
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     DEST_TYPE_0662
     INSTANCE_0662
     NUM_BYTES_0662
     NUM_MSGS_0662
     SERVER_NAME

EXSPI_0663
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SRC_TYPE_0663
     INSTANCE_0663
     NUM_BYTES_0663
     NUM_MSGS_0663
      SERVER_NAME

EXSPI_M1002
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     FROMSYSTEM
     INSTANCEVAL
     MEASUREDTIME
     MSE_DEST_SITE
     MSE_ORIG_SITE
     PINGTIMESTAMP
     SLA
     SLAAPPROACH
     TIMEOUT
     TOSYSTEM
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EXSPI_CMR
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     STORAGEGROUP_NAME
     DATABASE_NAME
     INSTANCEVAL
     READSIZE
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
     RUNTIME
     INTERVAL_KEY

EXSPI_CML
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     STORAGEGROUP_NAME
     DATABASE_NAME
     INSTANCEVAL
     LOGONSIZE
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
     RUNTIME
     INTERVAL_KEY
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EXSPI_CMS
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     STORAGEGROUP_NAME
     DATABASE_NAME
     INSTANCEVAL
     SENDSIZE
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
     RUNTIME
     INTERVAL_KEY

EXSPI_POP3PERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     POP3CON
     POP3FAILEDCON
     POP3REJECTEDCON
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EXSPI_DELIV
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_KEY
     SERVER_NAME
     DELIVSTATUS
     SLATIME
     SLAPERCENT
     DELIVTOTAL
     PERCENTMET
     TOTALMISSEDSLA
     AVERAGEDELIV
     ORIGSVR
     INTERVAL_KEY

EXSPI_PFDETAIL
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     STORAGEGROUP_NAME
     DATABASE_NAME
     FOLDER_NAME
     FOLDER_LASTACCESS
     FOLDER_SIZE
     FOLDER_MSGCNT
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Embedded Performance Component (EPC) 
schema

EXSPI_ASNOTIFY
     ASNTOTAL
     ASNSENT
     ASNIGNORE
     ASNDISCARD
     ASNEXPIRED
     ASNBIFURCATED

EXSPI_ASYNC
    ASYNCUSERS
     ASYNCSENDMAIL
     ASYNCCMDS
     ASYNCCLIENTITEMS
     ASYNCSERVERITEMS
     ASYNCAD
     ASYNCCONNECT
     ASYNCPENDING
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EXSPI_CML
     INSTANCE_KEY
     SERVER_NAME
     STORAGEGROUP_NAME
     DATABASE_NAME
     INSTANCEVAL
     LOGONSIZE
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
     RUNTIME
     INTERVAL_KEY

EXSPI_CMR
     INSTANCE_KEY
     SERVER_NAME
     STORAGEGROUP_NAME
     DATABASE_NAME
     INSTANCEVAL
     READSIZE
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
     RUNTIME
     INTERVAL_KEY
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EXSPI_CMS
    INSTANCE_KEY
     SERVER_NAME
     STORAGEGROUP_NAME
     DATABASE_NAME
     INSTANCEVAL
     SENDSIZE
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
     RUNTIME
     INTERVAL_KEY

EXSPI_DELIV
     INSTANCE_KEY
     SERVER_NAME
     STATUS
     SLATIME
     SLAPERCENT
     DELIVTOTAL
     PERCENTMET
     TOTALMISSEDSLA
     AVERAGEDELIV
     ORIGINATING_SERVER
     INTERVAL_KEY

EXSPI_DSACCESS
    CACHEMISSESPERSEC
    CACHEHITSPERSEC

EXSPI_FTIDATA
     SERVER_NAME
     INSTANCE_NAME
     FTILOCATION
     FTISIZ
     FTIFREE
     FTITOTAL
     FTIFP
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EXSPI_IMAP4
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     IMAP4CON
     IMAP4FAILEDCON
     IMAP4REJECTEDCON
     IMAP4UID

EXSPI_ISCLIENT
     ISCLATENCY10
     ISCLATENCY5
     ISCLATENCY2
     ISCRPCATTEMPT
     ISCRPCSUCCEED
     ISCRPCFAIL
     ISCRPCFUNAV
     ISCRPCFBUSY
     ISCRPCFCANCEL
     ISCRPCFCALLFAIL
     ISCRPCFACCESSDENY
     ISCRPCFOTHER

EXSPI_ISPERF
     RPCREQUESTS
     RPCOPERATIONSPERSEC
     ISVMLARGESTBLOCK
     ISVMLARGEFREEBB
     ISVM16MBFREE
     ISUSERCNT
     ISCONNECTCNT
     ISANONUSERCNT
     ISACTIVEUSERCNT
     ISACTIVECONNECTCNT
     ISACTIVEANONUSERCNT
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EXSPI_M0660
    INSTANCE_KEY
    SERVER_NAME
    INSTANCE_0660
    NUM_BYTES_0660
    NUM_MSGS_0660
    COUNTER_0660

EXSPI_M0661
     INSTANCE_KEY
     SERVER_NAME
     INSTANCE_0661
     NUM_BYTES_0661
     NUM_MSGS_0661
     COUNTER_0661

EXSPI_M0662
    INSTANCE_KEY
     SERVER_NAME
     INSTANCE_0662
     NUM_BYTES_0662
     NUM_MSGS_0662
     DEST_TYPE_0662
     COUNTER_0662

EXSPI_M0663
     INSTANCE_KEY
     SERVER_NAME
     INSTANCE_0663
     NUM_BYTES_0663
     NUM_MSGS_0663
     SRC_TYPE_0663
     COUNTER_0663
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EXSPI_M1002
     INSTANCE_KEY
     INTERVAL_KEY
     SERVER_NAME
     MSE_ORIG_SITE
     MSE_DEST_SITE
     PINGTIMESTAMP
     FROMSYSTEM
     TOSYSTEM
     INSTANCEVAL
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME

EXSPI_MBDETAIL
     INSTANCE_KEY
     INTERVAL_KEY
     MAILBOX_NAME
     SERVER_NAME
     STORAGEGROUP_NAME
     DATABASE_NAME
     MAILBOX_SIZE
     MAILBOX_QUOTA
     MAILBOX_MSGCNT
     MAILBOX_LASTACCESS
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EXSPI_MBPERF
      INSTANCE_NAME
      SERVER_NAME
      MBSENDQ
      MBRECEIVEQ
      MBDELIVERYTIME
      MBLOCALDELIVER
      MBDELIVER
      MBSENT
      MBSUBMITTED
      MBRECIPIENT
      MBACTIVELOGON
      MBLOGON
      MBLOGONPEAK
      MBSIRATIO
      MBRECOVERITEMS
      MBRECOVERSIZE

EXSPI_MBSUMMARY
     INSTANCE_KEY
     STORAGEGROUP_NAME
     DATABASE_NAME
     SERVER_NAME
     ADMINGROUP
     EDBPATH
     STMPATH
     EDBSIZE
     STMSIZE
     EDBFREE
     STMFREE
     EDBTOTAL
     STMTOTAL
     MBLOGICALSIZE
     MAILBOX_USRCNT
     MAILBOX_MSGCNT
     INTERVAL_KEY
191



EXSPI_MTADATA
     SERVER_NAME
     INSTANCE_NAME
     MTADATABASEPATH
     MTADATABASESIZE
     MTADATABASEFREE
     MTADATABASETOTAL
     MTADATABASEFP

EXSPI_MTAPERF
     MTAWORKQ
     MTAMSGIN
     MTAMSGOUT
     MTARCPIN
     MTARCPOUT
     MTABYTESIN
     MTABYTESOUT

EXSPI_MTLDATA
     SERVER_NAME
     MTLPATH
     MTLSIZE
     MTLCNT
     MTLFREE
     MTLTOTAL
     MTLFP

EXSPI_MULTI
     INSTANCE_KEY
     SERVER_NAME
     METRIC_ID
     VALUE_ID
     INSTANCE
     VALUE
     INTERVAL_KEY
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EXSPI_OMA
     OMASENT
     OMAIGNORE
     OMADISCARD
     OMARESPONSE

EXSPI_OWABE
     INSTANCE_NAME
     SERVER_NAME
     OWAMSGSSENT
     OWAMSGSOPEN
     OWAAUTHS
     OWAAUTHSCACHE
     OWARECENTAUTHS

EXSPI_OWAFE
     INSTANCE_NAME
     OWACONNECTIONS
     OWAMAXCONNECTIONS

EXSPI_PFDETAIL
     INSTANCE_KEY
     INTERVAL_KEY
     FOLDER_NAME
     SERVER_NAME
     STORAGEGROUP_NAME
     DATABASE_NAME
     FOLDER_SIZE
     FOLDER_MSGCNT
     FOLDER_LASTACCESS
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EXSPI_PFPERF
     INSTANCE_NAME
     SERVER_NAME
     PFSENDQ
     PFRECEIVEQ
     PFDELIVERYTIME
     PFDELIVER
     PFSENT
     PFSUBMITTED
     PFRECIPIENT
     PFACTIVELOGON
     PFLOGON
     PFLOGONPEAK
     PFSIRATIO
     PFRECOVERITEMS
     PFRECOVERSIZE
     PFREPRCVD
     PFREPSENT
     PFREPQ

EXSPI_PFSUMMARY
     INSTANCE_KEY
     STORAGEGROUP_NAME
     DATABASE_NAME
     SERVER_NAME
    ADMINGROUP
     EDBPATH
     STMPATH
     EDBSIZE
     STMSIZE
    EDBFREE
     STMFREE
     EDBTOTAL
     STMTOTAL
     PFLOGICALSIZE
     FOLDER_COUNT
     FOLDER_MSGCNT
     INTERVAL_KEY
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EXSPI_POP3
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     POP3CONN
     POP3FAILEDCON
     POP3REJECTEDCON
     POP3DELE
     POP3RETR

EXSPI_PORTS
     SERVER_NAME
     PORT_NAME
     PORT_NUMBER
     SERVICE_PROVIDER
     SENT_BYTE
     RECV_BYTE
     RESP_TIME
     CONFIG_TIMEOUT

EXSPI_SINGLE
     Version
     Reserve 1
     Reserve 2
     IS Active User Count
     IS User Count
     MTA Inbound Msgs Tot
     MTA Outb. Msgs Tot
     MTA Tot. Recip. Inb.
     MTA Tot. Recip. Outb
     MTA Inb. Bytes Total
     MTA Out. Bytes Total
     Priv.IS Local Deliv.
     Priv.IS Msgs Deliv.
     Priv.IS Msgs Sent
     Priv.IS Msgs Submit.
     Priv.IS Recip. Deli.
     Pub.IS Msgs Deliv.
     Pub.IS Msgs Sent
     Pub.IS Msgs Submit.
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(cont.)
     Pub.IS Recip. Deliv.
     Newsfeed Msgs Sent
     Newsfeed Msgs Receiv
     NNTP Messages Read
     NNTP Messages Posted
     MTA Queue length
     Priv.IS Send Queue
     Priv.IS Recei. Queue
     Pub.IS Send Queue
     Pub.IS Recei. Queue
     Priv.IS Avg Local
     Priv.IS Avg Delivery
     Pub.IS Avg Local
     Pub.IS Avg Delivery
     IMC In Msgs Total
     IMC Out Msgs Total
     IMC Total In (KB)
     IMC Total Out (KB)
     IMC Tot. In Recip.
     IMC Tot. Out Recip.
     IMC Tot. Msgs Queued
     Priv.IS DB Size (MB)
     Priv. IS Tot. MBoxes
     Priv. IS Tot. Mesgs
     Priv. IS Log.DB Size
     Priv. IS Inst. Ratio
     Pub. IS DB Size (MB)
     Pub. IS Tot. Folders
     Pub. IS Tot. Mesgs
     Pub. IS Log. DB Size
     Pub. IS Inst. Ratio
     SERVER_NAME

EXSPI_SINGLE
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EXSPI_SMTPDATA
     SERVER_NAME
     INSTANCE_NAME
     SMTPBADMAILDIR
     SMTPBADMAILSIZE
     SMTPBADMAILCNT
     SMTPBADMAILFREE
     SMTPBADMAILTOTAL
     SMTPBADMAILFP
     SMTPPICKUPDIR
     SMTPPICKUPSIZE
     SMTPPICKUPCNT
     SMTPPICKUPFREE
     SMTPPICKUPTOTAL
     SMTPPICKUPFP
     SMTPQUEUEDIR
     SMTPQUEUESIZE
     SMTPQUEUECNT
     SMTPQUEUEFREE
     SMTPQUEUETOTAL
     SMTPQUEUEFP

EXSPI_SMTPPERF
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     SMTPMSGSENT
     SMTPMSGRECEIVE
     SMTPBYTESENT
     SMTPBYTERECEIVE
     SMTPMSGBYTESENT
     SMTPMSGBYTERECEIVE
     SMTPINBOUNDCON
     SMTPOUTBOUNDCON
     SMTPOUTBOUNDCONREF
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EXSPI_SMTPQ
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     REMOTERETRYQ
     REMOTEQ
     LOCALRETRYQ
     LOCALQ
     PENDINGROUTINGQ
     CATEGORIZERQ

EXSPI_SRS
     SRSDIRPATH
     SERVER_NAME
     SSRSDIRSIZE
     SRSDIRFREE
     SRSDIRTOTAL
     SRSDIRPF
     INTERVAL_KEY

EXSPI_TRANSLOG
     STORAGEGROUP_NAME
     SERVER_NAME
     TRANSLOGFILEPATH
     TRANSLOGFILESIZE
     TRANSLOGFILEFREE
     TRANSLOGFILETOTAL
     TRANSLOGFILEFP
     INTERVAL_KEY
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Appendix D
Creating service accounts for 
Exchange 2000 or 2003

The Exchange SPI collects data from many sources. In order to collect the many types of 
data, the Exchange SPI requires advanced user credentials. The simplest way to obtain 
these credentials is to have the OVO management agent run as Local System. If this is not 
possible in your organization, you'll need to create a special service account with the 
necessary privileges. 

This procedure outlines how to create a service account with advanced user credentials for 
Exchange 2000 or Exchange 2003 nodes.

Task 1: Create service account 

1 Log on to the system that hosts the managed node’s domain.

2 Select Start > Settings > Control Panel > Administrative Tools > Active Directory 
Users and Computers.
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3 Expand the Active Directory Users and Computers and right-click Users and select 
New > User,

4 In the New Object - User dialog, enter a user name for the new service account into 
the First Name and the User logon name fields.  

You must create a service account with these privileges in each Windows domain. You may use any 
user name you wish. Throughout this document we are using MSXSPI as the user name for the 
service account. 
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Figure 34 Entering the new service account name   

5 In the next window, enter Password/Confirm Password for the service account.

6 Select Password Never Expires. Then click Next.
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Figure 35 Setting password properties   

7 In the New Object dialog, deselect Create an Exchange mailbox, and click Next
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Figure 36 Deselecting creating a mailbox   

8 In the next dialog, complete creating the user by clicking Finish.

9 You are now back at the Active Directory Users and Computers dialog. In the right 
pane, right-click on the service account user just created and select Properties.

10 In the service account Properties page, select the General tab. Enter OVO Exchange 
SPI in the Display name and Description fields.
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Figure 37 Entering names in Properties dialog   

11 Select the Member Of tab, and click Add.

12 In the Select Group dialog select Exchange Domain Servers from the top pane. 
Click Add, then OK.

13 The new user is now a member of Domain Admins group. Click OK and exit the 
Active Directory Users and Computer dialog.
204



Appendix D
Figure 38 Confirming membership privileges   

Task 2: Add service account user to Local Administrators group

1 On each targeted Exchange 2000/2003 server, select Start > Settings > Control 
Panel. 

2 Double click Administrative Tools. Double click Computer Management, then 
open the Local Users and Groups folder. Select and open the Groups folder, then 
double click Administrators.
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3 In the Administrators Properties dialog, click the Add button. Select the correct 
Domain from the Look in drop down list. Select the new service account user from 
the list, and click Add.

4 Update the discovery policy EXSPI-6.0 Exchange Service Discovery, to include this 
new user.

5 This procedure needs to be carried out for each targeted Exchange 2000/2003 server.  

It can sometimes take a few hours for new group membership and rights to be 
applied to a service account. 
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Exchange Cluster terminology
Cluster

A cluster is a group of independent computers, called nodes, that present themselves to a 
network as a highly available single system.

Node

A system that is a member of a cluster, and has a working installation of the Cluster 
Service. 

Resources

Resources are physical or logical entities, such as applications, or services, under the 
control of the Cluster Service.

Cluster Resource Group

A Cluster resource group is a set of resources that are grouped together to be managed as a 
single unit for configuration and recovery purposes. Each resource in a resource group 
may be dependent on other resources within that group.

A resource group is the unit of failover in a cluster. 

Failover

Failover is the process of moving a resource group from one node to another in the case of 
a failure. A failover can occur automatically, in the case of a problem, or manually, 
initiated by an administrator.
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Failback

Is the process of returning a resource group to the node on which it was running before a 
failover happened.

Active/passive

A cluster is in Active/Passive mode when one node is active while another is passive/idle. 
Only when the active node fails or is taken offline, will the passive node becomes active.

Active/active

Each node is assigned some of the workload and process requests from clients. When one 
node fails or is taken offline, control of its resources are passed to the other node.

Virtual Server

A virtual server is a resource group and contains:

• A Network Name resource

• An IP Address resource

• The resources to be accessed by the clients of the virtual server.

A virtual server acts as a standalone system. Clients on the network interact with the 
virtual server just as if it were a physical server.

Exchange Server Cluster 

To create an Exchange Server cluster, services provided by the Windows Cluster service 
are needed. Microsoft Exchange Server installs custom files and resources when installing 
the cluster-aware version of Exchange. This cluster-aware version of Exchange is installed 
when Exchange Server Setup is run on a node of a Windows Server cluster.

Exchange Virtual Server (EVS)

If Exchange is installed in a Windows Cluster; the EVS is the network name of a cluster 
resource group which contains:

• A Network Name resource

• An IP Address resource

• A Disk Resource on a common storage subsystem.

Additional resources represent the various components of Exchange:
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— System Attendant

— Information Store

— Routing

— Message Tracking Agent

— MSSearch

— Protocol

— SMTP

— HTTP

— POP3

— IMAP

 The EVS runs as a unit on one node in the cluster at any given time. It may also be limited 
to a subset of the total nodes in the cluster.
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A
access permissions, granting, 143, 145
Add-Ons policy group, Exchange 5.5, 33
Advanced Exchange Data Collection, 20
Advanced policy group, Exchange 5.5, 33
alerts, policies, 28
AlmostMetSLA, 119
Auto Deploy policies

Exchange 2000, 77
Exchange 2003, 68

C
capacity management and planning, improving, 10
Client SLA Configurations, 36
clustered application configuration file, 126
cluster environments, configuring Exchange SPI 

for, 125
cluster support, 125, 207
cluster terminology, 207

D
daily tasks, suggested, 62
destination mailbox, 118
Discovery policy group, Exchange 5.5, 33

E
End-to-End Message Ping alarms, 120, 121
Exchange availability and performance, increasing, 

10
Exchange organization service maps, 11
Exchange SPI policies, removing, 161
Exchange SPI programs, uninstalling from 

management server, 162
Exchange topology, 10
Exchange Topology viewer

using, 16

G
graphs

Exchange 2000 graphs, 107
Exchange 2003 graphs, 107
Exchange 5.5, 110

H
high availability environments, 125

I
instrumentation files, 163
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M
mailboxes, creating, 115
management server, removing policy groups, 161
managing enterprise Exchange environment, 10
manual deployment

Exchange 2000 and 2003, 86
Manual Deploy policies

Exchange 2000, 84
Exchange 2003, 75

message browser, 62
messages

enabling tracking
5.5 servers, 93, 94

policies, 28
testing delivery/receipt, 117, 119

MetSLA, 119
mission critical monitoring, 10
monitoring configuration file, 126
msexchange.apm.xml, 126
msexchange.apm.xml, modifying, 125

O
OVO message browser, 62
OV Topology Viewer, 37

map, modifying display of, 22
moving sites outside map, 22

P
passwords

modifying policies to include service accounts, 
121

modifying the EXPSI Reporter Collection 
Policies, 90, 91

policies
creating new group, 155, 157
customizing, 155, 160
displaying, 30
modifying to include service account 

password, 121
tagging, 157, 160

policies grouped by type folder, 34
policy group descriptions

Exchange 5.5, 88
procedures

mailboxes, creating, 115, 116
message tracking, enabling

5.5 servers, 93, 94
policies

creating a new group, 155, 157
editing to include service account 

password, 121
tagging, 157, 160

Reporter Collection Policies
editing, 92

Reporter Collection Policies, deploying, 90, 92
servers, configuring, 119
service accounts

creating (NT), 137, 143
creating in W2k/Ex2000 or 2003, 199, 204
creating in W2k/EX5.5, 146, 147
grant access permission in W2k/EX5.5, 

153, 154
granting access permissions, 143, 145

Q
Quick Start policy group, Exchange 5.5, 33

R
Reporter Collection Policies

deploying, 90, 92
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reports
Exchange 5.5, 90
time interval for generation, 95

S
server-monitoring capabilities, 10
servers, configuring, 119
service accounts

access permissions
granting, 143, 145

creating
NT4/EX5.5, 137, 143
W2k/Ex 2000 or 2003, 204
W2k/Ex2000 or 2003, 199

creating in W2k/EX5.5, 146, 147
grant access permissions

W2k/EX5.5, 153, 154
mailboxes, creating, 115, 116
modifying the EXSPI Report Collection 

Policies to include passwords, 90, 91
password, modifying policy to include, 121

service level agreements, 111
Service Reporter schema, 167
Site Topology, 21
SLA

for Exchange 2000/2003, 112
for Exchange 5.5, 115

source mailbox, 118
source server, 118
support costs, lowering, 10

T
tag feature, using, 155
tasks, suggested daily, 62
timeout, 118

tools
Configure Client MAPI Logon, 36
Configure Client Message Read, 36
Configure Client Message Send, 36
Embedded Performance Component 

Configuration, 38
Enable Message Tracking, 37
End-to-End Configuration, 37
Exchange Cluster Configuration tool, 38
MBOX Config, 37
MBOX creation for MAPI client based 

policies, 36
Mount Exchange Information Store, 37
OV Topology Viewer

data collection permissions, 20
getting started with, 21
map, changing, 22

removing from management server, 162
Self Healing Info, 37
Trace On/Tracing Off tools, 37
tracing, 35
using, 35

U
uninstalling, 161
uninstalling Exchange SPI from management 

server, 161
upgrading, 45

V
version details, 45
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